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Where to Start

We Can Get You from Here …

… to Here

PanelView™ Standard 

SLC™ 500 Controller PLC-5® Controller ControlLogix® 

PanelView Plus 7 Terminal

SLC 500 Controller PLC-5 Controller ControlLogix 
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Where to Start
Follow this path to migrate your PanelView Standard terminal and application 
to the PanelView Plus 7 terminal platform.

Chapter 1
Things to Know Before 

You Migrate

Chapter 2
Select a Terminal 

Replacement

Chapter 3
Import Your Application 

Chapter 4
Review the Application 

Conversion Log

Chapter 5
Review Object Mapping

Chapter 9
Optimize Runtime 

Performance

Appendix A
Advanced Object 

Editing

Chapter 6
Review Unsupported 

Features

Chapter 7
Qualify the Runtime 

Application

Before you update the migrated 
application, review the conversion 
log details and the remaining 
chapters. If you determine that the 
conversion operation would not be 
feasible, you can use the conversion 
services that are provided by 
Rockwell Automation. For more 
information, see Conversion 
Services, publication GMSC10-
PP009.

Chapter 8
Create the Runtime 

Application
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Preface

Introduction This document provides guidelines and procedures for migrating a PanelView™ 
Standard terminal application to the PanelView Plus 7 terminal platform. The 
procedures and guidelines cover the following:

• Selecting and optionally installing a PanelView Plus 7 terminal 
replacement

• Importing your PanelView Standard application into the FactoryTalk® 
View Machine Edition software

• Updating the imported application and ladder logic, as necessary, for 
compatibility with FactoryTalk View Machine Edition software

• Reviewing unsupported features
• Verifying the correct operation of the imported application on the 

PanelView Plus 7 terminal
• Measuring and improving performance of the migrated application

The procedures and guidelines are designed to make the migration process as 
easy as possible.

The beginning of most chapters contains the following information. Read 
these sections carefully before beginning work in each chapter.

• Before You Begin - This section lists the steps that must be completed 
and decisions that must be made before starting the chapter. The 
chapters in this quick start must be completed or reviewed in the order 
in which they appear.

• What You Need - This section lists the items that are required to 
complete the steps in the current chapter. These items include, but are 
not limited to, hardware and software.

• Follow These Steps - This section illustrates the path or steps in the 
current chapter.

Also note that the electronic version of this publication contains links to other 
publications for easier navigation and reference.

Audience This quick start was created to assist a user familiar with Rockwell Automation® 
HMI products on how to convert existing PanelView Standard applications to 
FactoryTalk View Machine Edition applications that run on PanelView Plus 7 
terminals.
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Preface
Required Software The table lists the software that is required to convert a PanelView Standard 
application to a PanelView Plus 7 application.

Software Terminal Type Software Version

FactoryTalk View Studio, which includes:
FactoryTalk View Machine Edition
RSLinx® Enterprise

PanelView Plus 7 Standard 4.0 or later

PanelView Plus 7 Performance 5.1 or earlier

PanelView Plus 7 Performance 6.0 or later

PanelBuilder®32 — 3.83 or earlier
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Chapter 1

Things to Know Before You Migrate

Introduction This chapter covers important considerations and helpful things to know 
before migrating a PanelView™ Standard application to a PanelView Plus 7 
platform. 

The table covers important considerations when migrating an application.

External Fonts Before importing a PanelBuilder®32 application that uses external fonts, make 
sure that the external font file is in this directory:

C:\Program Files\Allen-Bradley\PBEX\Fonts

If the conversion utility does not find the external font in this location, the 
conversion stops without reporting an error.

Table 1 - Migration Considerations

Migration Consideration Explanation For More Information

Application reuse? Do you need to reuse your PanelView Standard application and PLC ladder logic? If so, 
you can convert your application for use with a PanelView Plus terminal using 
FactoryTalk® View Machine Edition (ME) software. The application and PLC ladder 
logic may require updates because some objects or features may not directly migrate 
to FactoryTalk View ME software. 
If you want to create a FactoryTalk View ME application instead of reusing your 
current application, stop here.

Refer to Reviewing Object Mapping on 
page 58

Refer to Reviewing Unsupported Features on 
page 62

Require enhanced features? Does your application require enhanced features? If so, you can take advantage of the 
advanced features that are offered by the PanelView Plus 7 terminals:
• Functions: trending, data logging, alarming, information and local messages, 

expressions, security, language switching, recipes, global objects, multiversion 
support, faceplates, graphic libraries, parameter files, rich graphics, and 
animation.

• Communication: Ethernet and third-party connectivity to additional protocols. 
Ethernet is the preferred communication.

• Hardware: 8-wire analog resistive touch screen, x86 
1 GHz processor, 512 MB RAM and 512 MB nonvolatile memory, USB and Secure 
Digital (SD) media support, modular display, communication, and logic 
components. 

• Remote connectivity: FTP server, web server, VNC client/server, ActiveX 
controls, PDF reader, and FactoryTalk ViewPoint remote access is available on all 
PanelView Plus 7 Standard and Performance terminals.

• Extended features: PanelView Plus 7 Performance terminals include a web 
browser, remote desktop connection, Microsoft Office file viewers, and WordPad 
text editor.

Terminal replacement options? The terminal replacement for the PanelView Standard platform is the PanelView Plus 
7 platform.

Refer to Selecting a Terminal Replacement 
on page 14
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Chapter 1            
Retain Last States on Startup PanelBuilder32 software lets you choose to retain the last states on startup for 
all objects. FactoryTalk View Machine Edition (ME) software does not have 
this feature.

Unsupported Characters in 
Tag Names and Addresses

PanelBuilder32 software supports semicolons (;) in tag addresses; FactoryTalk 
View ME software does not. Before importing your application into 
FactoryTalk View ME software, change the semicolons (;) to colons (:) in the 
PanelBuilder32 tag editor.

PanelBuilder32 software supports dashes (-) in tag names, FactoryTalk View 
ME software does not. Before importing your application to FactoryTalk View 
ME software, search the PanelBuilder32 tag editor for tag names with dashes 
and duplicate the tags. Rename the tags to eliminate the dash, or replace the 
dash with an underscore (_). Use the tag search function to find graphic objects 
using the original tag names. Edit the objects to update the tag names.

Bit Array Tags You can monitor bit arrays for alarm conditions in FactoryTalk View 
applications but you can’t assign bit arrays to graphic objects, or write to bit 
arrays. This condition means all bit array tags in your PanelBuilder32 
application are converted to memory tags in the FactoryTalk View ME 
application. 

String Tags At runtime, FactoryTalk View ME applications support a maximum length of 
82 characters. Because PanelBuilder32 protocols support longer strings, some 
alarm messages may be truncated after conversion.

Alarm Trigger Tags Bit arrays with the Bit or LSBit trigger types are used to trigger alarm messages 
in a FactoryTalk View ME application. Assigning alarm triggers to elements in 
a bit array, instead of bit addresses, frees up tags in the database for other uses. 
When an element of an array changes from 0 to 1, it can generate an alarm 
message if a message has been created for that bit position. With the Bit trigger 
type, you can generate simultaneous alarm messages, one for each element. 
With the LSB trigger type, only the lowest bit position triggers an alarm:

• In a PanelBuilder32 application, the trigger value for the bit data type 
ranges from 0…31.

• In a FactoryTalk View ME application, the trigger value for the bit data 
type ranges from 1…32.

The number of bits in the array depends on the data type of the tag. Integer 
data types, for example, return 16 bits per element, while Bit data types return 
8 bits per element.
8 Rockwell Automation Publication 2711P-AP006E-EN-P - August 2022



           Chapter 1
To trigger a digital alarm that is based on an array of controller bits, you must 
use a direct reference and the syntax: 

tagname,Larraylength (for example, [PLC5]N7:0,L5) 

Bit Position Triggers

Follow these steps in the FactoryTalk View ME application to trigger alarms by 
using bit positions.

1. In the Trigger tab of the Alarm Setup editor, create a Bit type alarm 
trigger.

2. In the Trigger dialog box, click Browse in the Tag column and browse to 
the first element of an array. 

For example, in a Logix5000™ controller that is called CLGX1, select 
AAlm[0], which is an integer tag type.

3. Click OK to insert the tag address into your trigger tag. 

This address {[CLGX1]AAlm[0]} is the starting element in your array 
tag. [CLGX1] is the direct reference or the RSLinx® Enterprise device 
shortcut name. 

4. Double-click the address and append a comma and the letter L to the 
address, then type the number of elements you want to include in your 
array tag. 

To add 64 elements to the example address, modify it to read 
{[CLGX1]AAlm[0],L64]}. This syntax returns (64 x 16 =) 1024 bits. 
Do not leave a space between the tag address and the length.

5. In the Messages tab, assign trigger values and alarm messages to as many 
of the elements in the array tag as you like. 

Each trigger value corresponds to a bit position, not a bit address.

TIP Don’t leave a space between the tag address and the length. For example, 
the address {[SLC]BlockWrite1, L8}, where BlockWrite is the equivalent of 
N7:0, does not work. {[SLC]BlockWrite1,L8} works.
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Chapter 1            
In the Trigger Value column, enter a number for the element that triggers the 
message, then create the message in the Message column. When that element in 
the array changes value, it triggers the alarm and display the message.

Least Significant Bit Triggers

Follow these steps to trigger alarms using Least Significant Bit positions.

1. In the Trigger tab of the Alarm Setup editor, create an LSBit type alarm 
trigger.

2. In the Trigger dialog box, click Browse in the Tag column and browse to 
the first element of an array.

For example, in a PLC-5® controller, select an integer tag N7:61. For this 
example, only the first three-bit positions are used, so there’s no need to 
specify a length (L) for the array. To also monitor bits in N7:62, add L2 
to the address: [PLC5]N7:61,L2.

3. Specify these trigger values and alarm messages for the alarm trigger.

If the motor loses power at runtime, all three-bit values change from 0 to 1. 
Only the first alarm message is generated, because bit 00 is the least significant 
or the lowest bit. If the operator acknowledges the first alarm and power is not 
yet restored, the second alarm is generated, and so on.

Alarm Messages Both PanelBuilder 32 and Machine Edition applications perform the same 
three steps when an alarm is triggered.

1. Send the alarm message to the Data Tag connection.

2. Set the Notification Tag connection to 1.

3. Reset the Notification Tag connection to 0 when the Handshake tag 
changes to a nonzero value.

Bit Position Trigger Value Message

1 1 Line 1: Conveyor has stopped

2 2 Line 1: Power failure

3 3 Line 2: Conveyor has stopped

4 4 Line 2: Power failure

... ... ...

1024 1024 Line 6: Oven door open

Bit in Array Bit Position Trigger Value Message

00 1 1 Motor has lost power

01 2 2 Motor has stopped

02 3 3 Overload switch has lost power
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           Chapter 1
The PanelBuilder32 application performs additional steps that are not 
required by the ME application.

4. Send Null (00) to the Data Tag, overwriting the alarm message.

5. Set the Notification Tag to 1.

6. Reset the Notification Tag to 0 when the Handshake tag changes to a 
new nonzero value.

The Data tag is now ready to accept a new alarm message.

Tags Assigned to Message 
Connections

Some PanelBuilder32 tags are assigned to Message connections in the 
converted Machine Edition application.

This Tag in PanelBuilder32 Is Assigned to This Connection in ME

Remote Device Data tag Message connection

Remote Device Notification tag Message Notification connection

Remote Device Handshake tag Message Handshake connection
Rockwell Automation Publication 2711P-AP006E-EN-P - August 2022 11
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Notes:
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Chapter 2

Select a Terminal Replacement

Introduction In this chapter, you select and optionally install a PanelView™ Plus 7 terminal 
replacement for your PanelView Standard terminal. 

Before You Begin Review the migration considerations table (chapter 1).

Follow These Steps Follow these steps to select a PanelView Plus 7 terminal as a replacement for 
your PanelView Standard terminal.

Selecting a Terminal 
Replacement

Page 14

Installing a PanelView Plus 7 
Terminal

Page 42

Function Key Comparisons

Page 41
Rockwell Automation Publication 2711P-AP006E-EN-P - August 2022 13



Chapter 2            
Selecting a Terminal 
Replacement

Replacement options for the PanelView Standard terminals include the 
following platforms:

• PanelView Plus 7 Performance terminals
• PanelView Plus 7 Standard terminals

Some of the PanelView Plus 7 terminals fit directly into the existing panel 
cutouts of the PanelView Standard terminals; others require an adapter kit.

None of the PanelView Plus 7 terminals fit into the panel cutouts of the 
PanelView Standard 300 or 300 Micro terminals.

TIP• References to PanelView Plus 700, 1000, 1250, or 1500 terminals apply to both the PanelView 
Plus 6 (700...1500) and PanelView Plus 700 to 1500 platforms. 

• PanelView Plus Compact terminals use the same cutouts and adapter kits as the corresponding 
PanelView Plus 400, 600, and 1000 models.
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           Chapter 2
Catalog Number Conversion Tables

Tables in this section provide a direct catalog number conversion for your 
PanelView Standard terminal to a compatible PanelView Plus 7 terminal.

PanelView Standard 300 and 300 Micro Terminals Conversions

See the tables in this section for primary and secondary conversions for 
PanelView Standard 300 and 300 Micro terminals.

PanelView Standard 300 and 300 Micro Terminals Primary Replacement Options

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Display 
Resolution Comm.

Adapter 
Kit Cat. 
No.

Notes

300

2711-K3A5L1K

178 
(6.99)

109 
(4.29)

128 x 64

RS-232 
(DF1)

2711P-T4W21D8S 92 
(3.62)

117 
(4.61) 480 x 272

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 4-in. 
terminal benefits:
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 500
• Max. number of controllers: 1
Communication = Ethernet 
(dual Ethernet ports are 
available).
Operator input = only touch.
Power input = only DC.
Conformal coat = No.

2711-K3A10L1 DH-485

2711-K3A17L1 RS-232
(D-485)

2711-K3A2L1 RS-232
(D-485)

2711-K3A5L1 DeviceNet 
and RS-232

300 
Micro

2711-M3A18L1 102
(4.00)

92 
(3.62)

RS-232 
(DF1)2711-M3A19L1

PanelView Standard 300 and 300 Micro Terminals Secondary Replacement Options

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Display 
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Adapter 
Kit Cat. 
No.

Notes

300

2711-K3A5L1K

178
(6.99)

109 
(4.29)

128 x 64

RS-232 
(DF1)

2711P-B7C22D9P 142 
(5.59)

237 
(9.33) 640 x 480

Dual 
Ethernet 
ports

N/A

PanelView Plus 7 Performance 
6.5 in. terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = keypad and 
touch.
Power input = only DC.
Conformal coat = No.

2711-K3A10L1 DH-485

2711-K3A17L1 RS-232
(D-485)

2711-K3A2L1 RS-232
(D-485)

2711-K3A5L1 DeviceNet 
and RS-232

300 
Micro

2711-M3A18L1 102
(4.00)

92 
(3.62)

RS-232 
(DF1)2711-M3A19L1
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Chapter 2            
PanelView Standard 550 Terminals Conversions

See the tables in this section for primary and secondary conversions for 
PanelView Standard 550 terminals.

PanelView Standard 550 Terminals Primary Replacement Options 

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Display 
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Adapter 
Kit Cat. 
No.

Notes

550

2711-K5A1

144
(5.66)

243 
(9.55) 256 x 128

Remote I/O

2711P-T6C21D8S 123 
(4.84)

156 
(6.14) 640 x 480

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 6 in. 
terminal benefits:
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 500
• Max. number of controllers: 1
Communication = Ethernet 
(dual Ethernet ports are 
available).
Operator input = only touch.
Power input = only DC.
Conformal coat = No.

2711-K5A1L1

2711-K5A10

DeviceNet
2711-K5A10L1

2711-K5A14

2711-K5A14L1

2711-K5A12
RS-232

2711-K5A12L1

2711-K5A16 RS-232 
(DF1)2711-K5A16L1

2711-K5A15
ControlNet

2711-K5A15L1

2711-K5A2

DH-485
2711-K5A2L1

2711-K5A3

2711-K5A3L1

2711-K5A5

RS-232
(DH-485)

2711-K5A5L1

2711-K5A9

2711-K5A9L1

2711-K5A8
DH+™

2711-K5A8L1

2711-K5A20
EtherNet/IP

2711-K5A20L1

2711-B5A1
Remote I/O

2711-B5A1L1

2711-B5A10

DeviceNet
2711-B5A10L1

2711-B5A14

2711-B5A14L1

2711-B5A12
RS-232

2711-B5A12L1

2711-B5A16 RS-232 
(DF1)2711-B5A16L1
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           Chapter 2
550

2711-B5A15

144
(5.66)

243 
(9.55) 256 x 128

ControlNet

2711P-T6C21D8S 123 
(4.84)

156 
(6.14) 640 x 480

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 6 in. 
terminal benefits:
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 500
• Max. number of controllers: 1
Communication = Ethernet 
(dual Ethernet ports are 
available).
Operator input = only touch.
Power input = only DC.
Conformal coat = No.

2711-B5A15L1

2711-B5A2

DH-485
2711-B5A2L1

2711-B5A3

2711-B5A3L1

2711-B5A5

RS-232 
(DH-485)

2711-B5A5L1

2711-B5A9

2711-B5A9L1

2711-B5A8
DH+

2711-B5A8L1

2711-B5A20
EtherNet/IP

2711-B5A20L1

2711-T5A1L1

125
(4.91)

158 
(6.20) 256 x 128

Remote I/O

2711-T5A10L1
DeviceNet

2711-T5A14L1

2711-T5A12L1 RS-232

2711-T5A16L1 RS-232 
(DF1)

2711-T5A15L1 ControlNet

2711-T5A2L1
DH-485

2711-T5A3L1

2711-T5A5L1 RS-232 
(DH-485)2711-T5A9L1

2711-T5A8L1 DH+

2711-T5A20L1 EtherNet/IP

PanelView Standard 550 Terminals Primary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Notes
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PanelView Standard 550 Terminals Secondary Replacement Options 

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Display 
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Adapter 
Kit Cat. 
No.

Notes

550

2711-K5A1

144
(5.66)

243 
(9.55) 256 x 128

Remote I/O
2711P-B7C22A9P(1)

142 
(5.59)

237 
(9.33) 640 x 480

Dual 
Ethernet 
ports

N/A

PanelView Plus 7 Performance 
6.5 in. terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = keypad and 
touch.
Power input = AC or DC.(1)

Conformal coat = No.

2711-K5A1L1 2711P-B7C22D9P

2711-K5A10

DeviceNet

2711P-B7C22A9P(1)

2711-K5A10L1 2711P-B7C22D9P

2711-K5A14 2711P-B7C22A9P(1)

2711-K5A14L1 2711P-B7C22D9P

2711-K5A12
RS-232

2711P-B7C22A9P(1)

2711-K5A12L1 2711P-B7C22D9P

2711-K5A16 RS-232 
(DF1)

2711P-B7C22A9P(1)

2711-K5A16L1 2711P-B7C22D9P

2711-K5A15
ControlNet

2711P-B7C22A9P(1)

2711-K5A15L1 2711P-B7C22D9P

2711-K5A2

DH-485

2711P-B7C22A9P(1)

2711-K5A2L1 2711P-B7C22D9P

2711-K5A3 2711P-B7C22A9P(1)

2711-K5A3L1 2711P-B7C22D9P

2711-K5A5

RS-232
(DH-485)

2711P-B7C22A9P(1)

2711-K5A5L1 2711P-B7C22D9P

2711-K5A9 2711P-B7C22A9P(1)

2711-K5A9L1 2711P-B7C22D9P

2711-K5A8
DH+

2711P-B7C22A9P(1)

2711-K5A8L1 2711P-B7C22D9P

2711-K5A20
EtherNet/IP

2711P-B7C22A9P(1)

2711-K5A20L1 2711P-B7C22D9P

2711-B5A1
Remote I/O

2711P-B7C22A9P(1)

2711-B5A1L1 2711P-B7C22D9P

2711-B5A10

DeviceNet

2711P-B7C22A9P(1)

2711-B5A10L1 2711P-B7C22D9P

2711-B5A14 2711P-B7C22A9P(1)

2711-B5A14L1 2711P-B7C22D9P

2711-B5A12
RS-232

2711P-B7C22A9P(1)

2711-B5A12L1 2711P-B7C22D9P

2711-B5A16 RS-232 
(DF1)

2711P-B7C22A9P(1)

2711-B5A16L1 2711P-B7C22D9P
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           Chapter 2
550

2711-B5A15

144
(5.66)

243 
(9.55) 256 x 128

ControlNet
2711P-B7C22A9P(1)

142 
(5.59)

237 
(9.33) 640 x 480

Dual 
Ethernet 
ports

N/A

PanelView Plus 7 Performance 
6.5 in. terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet. 
Operator input = keypad and 
touch.
Power input = AC or DC.(1)

Conformal coat = No.

2711-B5A15L1 2711P-B7C22D9P

2711-B5A2

DH-485

2711P-B7C22A9P(1)

2711-B5A2L1 2711P-B7C22D9P

2711-B5A3 2711P-B7C22A9P(1)

2711-B5A3L1 2711P-B7C22D9P

2711-B5A5

RS-232 
(DH-485)

2711P-B7C22A9P(1)

2711-B5A5L1 2711P-B7C22D9P

2711-B5A9 2711P-B7C22A9P(1)

2711-B5A9L1 2711P-B7C22D9P

2711-B5A8
DH+

2711P-B7C22A9P(1)

2711-B5A8L1 2711P-B7C22D9P

2711-B5A20
EtherNet/IP

2711P-B7C22A9P(1)

2711-B5A20L1 2711P-B7C22D9P

2711-T5A1L1

125
(4.91)

158 
(6.20) 256 x 128

Remote I/O

2711P-T7C22D9P 142 
(5.59)

184 
(7.24) 640 x 480

PanelView Plus 7 Performance 
6.5 in. terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet. 
Operator input = only touch.
Power input = DC.
Conformal coat = Yes(2)

2711-T5A10L1
DeviceNet

2711-T5A14L1

2711-T5A12L1 RS-232

2711-T5A16L1 RS-232 
(DF1)

2711-T5A15L1 ControlNet

2711-T5A2L1
DH-485

2711-T5A3L1

2711-T5A5L1 RS-232 
(DH-485)2711-T5A9L1

2711-T5A8L1 DH+

2711-T5A20L1 EtherNet/IP

(1) AC power is only available on Series A terminals. DC power is only available on Series B terminals.
(2) Conformal coating is available for all DC-power, touch terminals. To order a terminal that is conformal-coated, add K to the end of a DC-power, touch catalog number; for example, 2711P-T7C22D9PK.

PanelView Standard 550 Terminals Secondary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options
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Chapter 2            
PanelView Standard 600 Terminals Conversions

See the tables in this section for primary and secondary conversions for 
PanelView Standard 600 terminals.

PanelView Standard 600 Terminals Primary Replacement Options 

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options

Panel Cutout 
Dimensions
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No.

Notes

600

2711-K6C1

167
(6.57)

264 
(10.39) 320 x 234

Remote I/O
2711P-B7C22A9P(1)

142 
(5.59)

237 
(9.33) 640 x 480

Dual 
Ethernet 
ports

2711P-
RAAK7

PanelView Plus 7 Performance 
6.5 in. terminals benefits:
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = keypad and 
touch.
Power input = AC or DC.(1)

Conformal coat = No.
Adapter kit is necessary for 
drop-in replacement.

2711-K6C1L1 2711P-B7C22D9P

2711-K6C10

DeviceNet

2711P-B7C22A9P(1)

2711-K6C10L1 2711P-B7C22D9P

2711-K6C14 2711P-B7C22A9P(1)

2711-K6C14L1 2711P-B7C22D9P

2711-K6C12
RS-232

2711P-B7C22A9P(1)

2711-K6C12L1 2711P-B7C22D9P

2711-K6C16 RS-232 
(DF1)

2711P-B7C22A9P(1)

2711-K6C16L1 2711P-B7C22D9P

2711-K6C15
ControlNet

2711P-B7C22A9P(1)

2711-K6C15L1 2711P-B7C22D9P

2711-K6C2

DH-485

2711P-B7C22A9P(1)

2711-K6C2L1 2711P-B7C22D9P

2711-K6C3 2711P-B7C22A9P(1)

2711-K6C3L1 2711P-B7C22D9P

2711-K6C5

RS-232
(DH-485)

2711P-B7C22A9P(1)

2711-K6C5L1 2711P-B7C22D9P

2711-K6C9 2711P-B7C22A9P(1)

2711-K6C9L1 2711P-B7C22D9P

2711-K6C8
DH+

2711P-B7C22A9P(1)

2711-K6C8L1 2711P-B7C22D9P

2711-K6C20
EtherNet/IP

2711P-B7C22A9P(1)

2711-K6C20L1 2711P-B7C22D9P

2711-B6C1
Remote I/O

2711P-B7C22A9P(1)

2711-B6C1L1 2711P-B7C22D9P

2711-B6C10

DeviceNet

2711P-B7C22A9P(1)

2711-B6C10L1 2711P-B7C22D9P

2711-B6C14 2711P-B7C22A9P(1)

2711-B6C14L1 2711P-B7C22D9P

2711-B6C12
RS-232

2711P-B7C22A9P(1)

2711-B6C12L1 2711P-B7C22D9P

2711-B6C16 RS-232 
(DF1)

2711P-B7C22A9P(1)

2711-B6C16L1 2711P-B7C22D9P
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600

2711-B6C15

167
(6.57)

264 
(10.39) 320 x 234

ControlNet
2711P-B7C22A9P(1)

142 
(5.59)

237 
(9.33) 640 x 480

Dual 
Ethernet 
ports

2711P-
RAAK7

PanelView Plus 7 Performance 
6.5 in. terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet. 
Operator input = keypad and 
touch.
Power input = AC or DC.(1)

Conformal coat = No.
Adapter kit is necessary for 
drop-in replacement.

2711-B6C15L1 2711P-B7C22D9P

2711-B6C2

DH-485

2711P-B7C22A9P(1)

2711-B6C2L1 2711P-B7C22D9P

2711-B6C3 2711P-B7C22A9P(1)

2711-B6C3L1 2711P-B7C22D9P

2711-B6C5

RS-232 
(DH-485)

2711P-B7C22A9P(1)

2711-B6C5L1 2711P-B7C22D9P

2711-B6C9 2711P-B7C22A9P(1)

2711-B6C9L1 2711P-B7C22D9P

2711-B6C8
DH+

2711P-B7C22A9P(1)

2711-B6C8L1 2711P-B7C22D9P

2711-B6C20
EtherNet/IP

2711P-B7C22A9P(1)

2711-B6C20L1 2711P-B7C22D9P

2711-T6C1L1

125
(4.91)

158 
(6.20) 320 x 234

Remote I/O

2711P-T6C21D8S 123 
(4.84)

156 
(6.14) 640 x 480

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 6 in. 
terminal benefits:
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 500
• Max. number of controllers: 1
Communication = Ethernet 
(dual Ethernet ports are 
available).
Operator input = only touch.
Power input = only DC.
Conformal coat = No.

2711-T6C10L1
DeviceNet

2711-T6C14L1

2711-T6C12L1 RS-232

2711-T6C16L1 RS-232 
(DF1)

2711-T6C15L1 ControlNet

2711-T6C2L1
DH-485

2711-T6C3L1

2711-T6C5L1 RS-232 
(DH-485)2711-T6C9L1

2711-T6C8L1 DH+

2711-T6C20L1 EtherNet/IP

(1) AC power is only available on Series A terminals. DC power is only available on Series B terminals.

PanelView Standard 600 Terminals Primary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options
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PanelView Standard 600 Terminals Secondary Replacement Options 

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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No.

Notes

600

2711-K6C1

167
(6.57)

264 
(10.39) 320 x 234

Remote I/O

2711P-T7C21D8S 142 
(5.59)

184 
(7.24) 640 x 480

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 6.5 in. 
terminal benefits:
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 500
• Max. number of controllers: 1
Communication = Ethernet (dual 
Ethernet ports are available).
Operator input = only touch.
Power input = only DC.
Conformal coat = No.

2711-K6C1L1

2711-K6C10

DeviceNet
2711-K6C10L1

2711-K6C14

2711-K6C14L1

2711-K6C12
RS-232

2711-K6C12L1

2711-K6C16 RS-232 
(DF1)2711-K6C16L1

2711-K6C15
ControlNet

2711-K6C15L1

2711-K6C2

DH-485
2711-K6C2L1

2711-K6C3

2711-K6C3L1

2711-K6C5

RS-232
(DH-485)

2711-K6C5L1

2711-K6C9

2711-K6C9L1

2711-K6C8
DH+

2711-K6C8L1

2711-K6C20
EtherNet/IP

2711-K6C20L1

2711-B6C1
Remote I/O

2711-B6C1L1

2711-B6C10

DeviceNet
2711-B6C10L1

2711-B6C14

2711-B6C14L1

2711-B6C12
RS-232

2711-B6C12L1

2711-B6C16 RS-232 
(DF1)2711-B6C16L1
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600

2711-B6C15

167
(6.57)

264 
(10.39) 320 x 234

ControlNet

2711P-T7C21D8S 142 
(5.59)

184 
(7.24) 640 x 480

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 6.5 in. 
terminal benefits:
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 500
• Max. number of controllers: 1
Communication = Ethernet (dual 
Ethernet ports are available).
Operator input = only touch.
Power input = only DC.
Conformal coat = No.

2711-B6C15L1

2711-B6C2

DH-485
2711-B6C2L1

2711-B6C3

2711-B6C3L1

2711-B6C5

RS-232 
(DH-485)

2711-B6C5L1

2711-B6C9

2711-B6C9L1

2711-B6C8
DH+

2711-B6C8L1

2711-B6C20
EtherNet/IP

2711-B6C20L1

2711-T6C1L1

125
(4.91)

158 
(6.20) 320 x 234

Remote I/O

2711P-T7C22D9P 142 
(5.59)

184 
(7.24) 640 x 480

Dual 
Ethernet 
ports

N/A

PanelView Plus 7 Performance 
6.5 in. terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet. 
Operator input = keypad and 
touch.
Power input = AC or DC.(1)

Conformal coat = Yes(2)

Adapter kit is necessary for drop-
in replacement.

2711-T6C10L1
DeviceNet

2711-T6C14L1

2711-T6C12L1 RS-232

2711-T6C16L1 RS-232 
(DF1)

2711-T6C15L1 ControlNet

2711-T6C2L1
DH-485

2711-T6C3L1

2711-T6C5L1 RS-232 
(DH-485)2711-T6C9L1

2711-T6C8L1 DH+

2711-T6C20L1 EtherNet/IP

(1) AC power is only available on Series A terminals. DC power is only available on Series B terminals.
(2) Conformal coating is available for all DC-power, touch terminals. To order a terminal that is conformal-coated, add K to the end of a DC-power, touch catalog number; for example, 2711P-T7C22D9PK.

PanelView Standard 600 Terminals Secondary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options
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PanelView Standard 900 Terminals Conversions

See the tables in this section for primary and secondary conversions for 
PanelView Standard 900 terminals.

PanelView Standard 900 Terminals Primary Replacement Options 

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
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Model Cat. No.
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No.

Notes

900

2711-K9A1

224
(8.80)

375 
(14.75)

640 x 400

Remote I/O
2711P-B10C22A9P

224 
(8.82)

335 
(13.19) 800 x 600

Dual 
Ethernet 
ports

2711P-
RAAK10

PanelView Plus 7 Performance 
10.4 in. terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = keypad and 
touch.
Power input = AC or DC.(1)

Conformal coat = No.
Adapter kit is necessary for 
drop-in replacement.

2711-K9A1L1 2711P-B10C22D9P

2711-K9A10

DeviceNet

2711P-B10C22A9P

2711-K9A10L1 2711P-B10C22D9P

2711-K9A14L1 2711P-B10C22D9P

2711-K9A12

RS-232

2711P-B10C22A9P

2711-K9A12L1 2711P-B10C22D9P

2711-K9A5 2711P-B10C22A9P

2711-K9A5L1 2711P-B10C22D9P

2711-K9A9 2711P-B10C22A9P

2711-K9A9L1 2711P-B10C22D9P

2711-K9A15
ControlNet

2711P-B10C22A9P

2711-K9A15L1 2711P-B10C22D9P

2711-K9A2

DH-485

2711P-B10C22A9P

2711-K9A2L1 2711P-B10C22D9P

2711-K9A3 2711P-B10C22A9P

2711-K9A3L1 2711P-B10C22D9P

2711-K9A8
DH+

2711P-B10C22A9P

2711-K9A8L1 2711P-B10C22D9P

2711-K9C1

640 x 480

Remote I/O
2711P-B10C22A9P

2711-K9C1L1 2711P-B10C22D9P

2711-K9C10

DeviceNet

2711P-B10C22A9P

2711-K9C10L1 2711P-B10C22D9P

2711-K9C14 2711P-B10C22A9P

2711-K9C14L1 2711P-B10C22D9P

2711-K9C12

RS-232

2711P-B10C22A9P

2711-K9C12L1 2711P-B10C22D9P

2711-K9C9 2711P-B10C22A9P

2711-K9C9L1 2711P-B10C22D9P

2711-K9C16 RS-232 
(DF1)

2711P-B10C22A9P

2711-K9C16L1 2711P-B10C22D9P

2711-K9C15
ControlNet

2711P-B10C22A9P

2711-K9C15L1 2711P-B10C22D9P

2711-K9C3 DH-485 2711P-B10C22A9P
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900

2711-K9C3L1

224
(8.80)

375
(14.75) 640 x 480

DH-485 2711P-B10C22D9P

224 
(8.82)

335 
(13.19)

800 x 600
Dual 
Ethernet 
ports

2711P-
RAAK10

PanelView Plus 7 Performance 
10.4 in. terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet. 
Operator input = keypad and 
touch.
Power input = AC or DC.(1)

Conformal coat = No.
Adapter kit is necessary for 
drop-in replacement.

2711-K9C8
DH+

2711P-B10C22A9P

2711-K9C8L1 2711P-B10C22D9P

2711-K9C20

Ethernet

2711P-B10C22A9P

2711-K9C20L1 2711P-B10C22D9P

2711-T9A1

305
(12.00)

640 x 400

Remote I/O
2711P-T10C22A9P

269 
(10.59)

2711P-
RAAT10

PanelView Plus 7 Performance 
10.4 in. terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = only touch.
Power input = AC or DC.(1)

Conformal coat = Yes(2)

Adapter kit is necessary for 
drop-in replacement.

2711-T9A1L1 2711P-T10C22D9P

2711-T9A10

DeviceNet

2711P-T10C22A9P

2711-T9A10L1 2711P-T10C22D9P

2711-T9A14L1 2711P-T10C22D9P

2711-T9A12

RS-232

2711P-T10C22A9P

2711-T9A12L1 2711P-T10C22D9P

2711-T9A5 2711P-T10C22A9P

2711-T9A5L1 2711P-T10C22D9P

2711-T9A9 2711P-T10C22A9P

2711-T9A9L1 2711P-T10C22D9P

2711-T9A15
ControlNet

2711P-T10C22A9P

2711-T9A15L1 2711P-T10C22D9P

2711-T9A2

DH-485

2711P-T10C22A9P

2711-T9A2L1 2711P-T10C22D9P

2711-T9A3 2711P-T10C22A9P

2711-T9A3L1 2711P-T10C22D9P

2711-T9A8
DH+

2711P-T10C22A9P

2711-T9A8L1 2711P-T10C22D9P

2711-T9C1

640 x 480

Remote I/O
2711P-T10C22A9P

2711-T9C1L1 2711P-T10C22D9P

2711-T9C10

DeviceNet

2711P-T10C22A9P

2711-T9C10L1 2711P-T10C22D9P

2711-T9C14 2711P-T10C22A9P

2711-T9C14L1 2711P-T10C22D9P

2711-T9C12
RS-232

2711P-T10C22A9P

2711-T9C12L1 2711P-T10C22D9P

2711-T9C16 RS-232 
(DF1)

2711P-T10C22A9P

2711-T9C16L1 2711P-T10C22D9P

2711-T9C15 ControlNet 2711P-T10C22A9P

PanelView Standard 900 Terminals Primary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options
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900

2711-T9C15L1

224
(8.80)

305 
(12.00) 640 x 480

ControlNet 2711P-T10C22D9P

224 
(8.82)

269 
(10.59) 800 x 600

Dual 
Ethernet 
ports

2711P-
RAAT10

PanelView Plus 7 Performance 
10.4 in. terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = only touch.
Power input = AC or DC.(1)

Conformal coat = Yes(2)

Adapter kit is necessary for 
drop-in replacement.

2711-T9C3
DH-485

2711P-T10C22A9P

2711-T9C3L1 2711P-T10C22D9P

2711-T9C9 RS-232 
(DH-485)

2711P-T10C22A9P

2711-T9C9L1 2711P-T10C22D9P

2711-T9C8
DH+

2711P-T10C22A9P

2711-T9C8L1 2711P-T10C22D9P

2711-T9C20
Ethernet

2711P-T10C22A9P

2711-T9C20L1 2711P-T10C22D9P

(1) AC power is only available on Series A terminals. DC power is only available on Series B terminals.
(2) Conformal coating is available for all DC-power, touch terminals. To order a terminal that is conformal-coated, add K to the end of a DC-power, touch catalog number; for example, 2711P-T10C22D9PK.

PanelView Standard 900 Terminals Primary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options
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PanelView Standard 900 Terminals Secondary Replacement Options 

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Resolution Comm. Cat. No.
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Display 
Resolution Comm.

Adapter 
Kit Cat. 
No.

Notes

900

2711-K9A1

224
(8.80)

375 
(14.75)

640 x 400

Remote I/O

2711P-T10C21D8S 224 
(8.82)

269 
(10.59) 800 x 600

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 
10.4 in. terminal benefits: 
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 500
• Max. number of controllers: 1
Communication = Ethernet 
(dual Ethernet ports are 
available).
Operator input = only touch.
Power input = only DC.
Conformal coat = No.

2711-K9A1L1

2711-K9A10

DeviceNet2711-K9A10L1

2711-K9A14L1

2711-K9A12

RS-232

2711-K9A12L1

2711-K9A5

2711-K9A5L1

2711-K9A9

2711-K9A9L1

2711-K9A15
ControlNet

2711-K9A15L1

2711-K9A2

DH-485
2711-K9A2L1

2711-K9A3

2711-K9A3L1

2711-K9A8
DH+

2711-K9A8L1

2711-K9C1

640 x 480

Remote I/O
2711-K9C1L1

2711-K9C10

DeviceNet
2711-K9C10L1

2711-K9C14

2711-K9C14L1

2711-K9C12

RS-232
2711-K9C12L1

2711-K9C9

2711-K9C9L1

2711-K9C16 RS-232 
(DF1)2711-K9C16L1

2711-K9C15
ControlNet

2711-K9C15L1

2711-K9C3 DH-485
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900

2711-K9C3L1

224
(8.80)

375
(14.75) 640 x 480

DH-485

2711P-T10C21D8S 224 
(8.82)

269 
(10.59) 800 x 600

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 
10.4 in. terminal benefits: 
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 500
• Max. number of controllers: 1
Communication = Ethernet 
(dual Ethernet ports are 
available).
Operator input = only touch.
Power input = only DC.
Conformal coat = No.

2711-K9C8
DH+

2711-K9C8L1

2711-K9C20
Ethernet

2711-K9C20L1

2711-T9A1

305
(12.00)

640 x 400

Remote I/O
2711-T9A1L1

2711-T9A10

DeviceNet2711-T9A10L1

2711-T9A14L1

2711-T9A12

RS-232

2711-T9A12L1

2711-T9A5

2711-T9A5L1

2711-T9A9

2711-T9A9L1

2711-T9A15
ControlNet

2711-T9A15L1

2711-T9A2

DH-485
2711-T9A2L1

2711-T9A3

2711-T9A3L1

2711-T9A8
DH+

2711-T9A8L1

2711-T9C1

640 x 480

Remote I/O
2711-T9C1L1

2711-T9C10

DeviceNet
2711-T9C10L1

2711-T9C14

2711-T9C14L1

2711-T9C12
RS-232

2711-T9C12L1

2711-T9C16 RS-232 
(DF1)2711-T9C16L1

2711-T9C15 ControlNet

PanelView Standard 900 Terminals Secondary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions
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No.

Notes
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900

2711-T9C15L1

224
(8.80)

305 
(12.00) 640 x 480

ControlNet

2711P-T10C21D8S 224 
(8.82)

269 
(10.59) 800 x 600

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 
10.4 in. terminal benefits: 
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 500
• Max. number of controllers: 1
Communication = Ethernet 
(dual Ethernet ports are 
available).
Operator input = only touch.
Power input = only DC.
Conformal coat = No.

2711-T9C3
DH-485

2711-T9C3L1

2711-T9C9 RS-232 
(DH-485)2711-T9C9L1

2711-T9C8
DH+

2711-T9C8L1

2711-T9C20
Ethernet

2711-T9C20L1

PanelView Standard 900 Terminals Secondary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Notes
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PanelView Standard 1000 Terminals Conversions

See the tables in this section for primary and secondary conversions for 
PanelView Standard 1000 terminals.

PanelView Standard 1000 Terminals Primary Replacement Options 

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.

He
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Display 
Resolution Comm. Cat. No.
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)

Display 
Resolution Comm.

Adapter 
Kit Cat. 
No.

Notes

1000

2711-K10C1

257
(10.11)

390 
(15.35) 640 x 480

Remote I/O
2711P-T12W22A9P

218 
(8.58)

312 
(12.28) 1280 x 800

Dual 
Ethernet 
ports

2711P-
RAAT12K

PanelView Plus 7 
Performance 12.1 in. 
terminal benefits:
• Wide screen has more 

usable screen area
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = only 
touch.
Power input = AC or DC.(1)

Conformal coat = Yes(2)

Adapter kit is necessary for 
drop-in replacement.

2711-K10C1L1 2711P-T12W22D9P

2711-K10C10

DeviceNet

2711P-T12W22A9P

2711-K10C10L1 2711P-T12W22D9P

2711-K10C14 2711P-T12W22A9P

2711-K10C14L1 2711P-T12W22D9P

2711-K10C12
RS-232

2711P-T12W22A9P

2711-K10C12L1 2711P-T12W22D9P

2711-K10C16 RS-232 
(DF1)

2711P-T12W22A9P

2711-K10C16L1 2711P-T12W22D9P

2711-K10C15
ControlNet

2711P-T12W22A9P

2711-K10C15L1 2711P-T12W22D9P

2711-K10C3
DH-485

2711P-T12W22A9P

2711-K10C3L1 2711P-T12W22D9P

2711-K10C9 RS-232 
(DH-485)

2711P-T12W22A9P

2711-K10C9L1 2711P-T12W22D9P

2711-K10C8
DH+

2711P-T12W22A9P

2711-K10C8L1 2711P-T12W22D9P

2711-K10C20
Ethernet

2711P-T12W22A9P

2711-K10C20L1 2711P-T12W22D9P

2711-K10G1
Remote I/O

2711P-T12W22A9P

2711-K10G1L1 2711P-T12W22D9P

2711-K10G10

DeviceNet

2711P-T12W22A9P

2711-K10G10L1 2711P-T12W22D9P

2711-K10G14 2711P-T12W22A9P

2711-K10G14L1 2711P-T12W22D9P

2711-K10G12
RS-232

2711P-T12W22A9P

2711-K10G12L1 2711P-T12W22D9P

2711-K10G16 RS-232 
(DF1)

2711P-T12W22A9P

2711-K10G16L1 2711P-T12W22D9P

2711-K10G15
ControlNet

2711P-T12W22A9P

2711-K10G15L1 2711P-T12W22D9P

2711-K10G3
DH-485

2711P-T12W22A9P

2711-K10G3L1 2711P-T12W22D9P
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1000

2711-K10G9

257
(10.11)

390
(15.35)

640 x 480

RS-232 
(DH-485)

2711P-T12W22A9P

218 
(8.58)

312 
(12.28) 1280 x 800

Dual 
Ethernet 
ports

2711P-
RAAT12K

PanelView Plus 7 
Performance 12.1 in. 
terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = only 
touch.
Power input = AC or DC.(1)

Conformal coat = Yes(2)

Adapter kit is necessary for 
drop-in replacement.

2711-K10G9L1 2711P-T12W22D9P

2711-K10G8
DH+

2711P-T12W22A9P

2711-K10G8L1 2711P-T12W22D9P

2711-K10G20
Ethernet

2711P-T12W22A9P

2711-K10G20L1 2711P-T12W22D9P

2711-T10C1

338
(13.29)

Remote I/O
2711P-T12W22A9P

2711P-
RAAT12

2711-T10C1L1 2711P-T12W22D9P

2711-T10C10

DeviceNet

2711P-T12W22A9P

2711-T10C10L1 2711P-T12W22D9P

2711-T10C14 2711P-T12W22A9P

2711-T10C14L1 2711P-T12W22D9P

2711-T10C12
RS-232

2711P-T12W22A9P

2711-T10C12L1 2711P-T12W22D9P

2711-T10C16 RS-232 
(DF1)

2711P-T12W22A9P

2711-T10C16L1 2711P-T12W22D9P

2711-T10C15
ControlNet

2711P-T12W22A9P

2711-T10C15L1 2711P-T12W22D9P

2711-T10C3
DH-485

2711P-T12W22A9P

2711-T10C3L1 2711P-T12W22D9P

2711-T10C9 RS-232 
(DH-485)

2711P-T12W22A9P

2711-T10C9L1 2711P-T12W22D9P

2711-T10C8
DH+

2711P-T12W22A9P

2711-T10C8L1 2711P-T12W22D9P

2711-T10C20
Ethernet

2711P-T12W22A9P

2711-T10C20L1 2711P-T12W22D9P

2711-T10G1
Remote I/O

2711P-T12W22A9P

2711-T10G1L1 2711P-T12W22D9P

2711-T10G10

DeviceNet

2711P-T12W22A9P

2711-T10G10L1 2711P-T12W22D9P

2711-T10G14 2711P-T12W22A9P

2711-T10G14L1 2711P-T12W22D9P

2711-T10G12
RS-232

2711P-T12W22A9P

2711-T10G12L1 2711P-T12W22D9P

2711-T10G16 RS-232 
(DF1) 2711P-T12W22A9P

PanelView Standard 1000 Terminals Primary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
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1000

2711-T10G16L1

257 
(10.11)

338 
(13.29) 640 x 480

RS-232 
(DF1) 2711P-T12W22D9P

218 
(8.58)

312 
(12.28) 1280 x 800

Dual 
Ethernet 
ports

2711P-
RAAT12

PanelView Plus 7 
Performance 12.1 in. 
terminal benefits:
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = only 
touch.
Power input = AC or DC.(1)

Conformal coat = Yes(2)

Adapter kit is necessary for 
drop-in replacement.

2711-T10G15
ControlNet

2711P-T12W22A9P

2711-T10G15L1 2711P-T12W22D9P

2711-T10G3
DH-485

2711P-T12W22A9P

2711-T10G3L1 2711P-T12W22D9P

2711-T10G9 RS-232 
(DH-485)

2711P-T12W22A9P

2711-T10G9L1 2711P-T12W22D9P

2711-T10G8
DH+

2711P-T12W22A9P

2711-T10G8L1 2711P-T12W22D9P

2711-T10G20
Ethernet

2711P-T12W22A9P

2711-T10G20L1 2711P-T12W22D9P

(1) AC power is only available on Series A terminals. DC power is only available on Series B terminals.
(2) Conformal coating is available for all DC-power, touch terminals. To order a terminal that is conformal-coated, add K to the end of a DC-power, touch catalog number; for example, 2711P-

T12W22D9PK.

PanelView Standard 1000 Terminals Primary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options

Panel Cutout 
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PanelView Standard 1000 Terminals Secondary Replacement Options 

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Resolution Comm. Cat. No.
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Display 
Resolution Comm.

Adapter 
Kit Cat. 
No.

Notes

1000

2711-K10C1

257 
(10.11)

390 
(15.35) 640 x 480

Remote I/O
2711P-B15C22A9P

290 
(11.42)

418 
(16.46) 1024 x 768

Dual 
Ethernet 
ports

N/A

PanelView Plus 7 
Performance 15 in. 
terminal benefits:
• Wide screen has more 

usable screen area
• Higher resolution
• DLR
Communication = 
Ethernet.
Operator input = The 15 in. 
terminal is listed as 
secondary replacement if 
you require a keypad.
Power input = AC or DC.(1)

Conformal coat = Yes(2)

2711-K10C1L1 2711P-B15C22D9P

2711-K10C10

DeviceNet

2711P-B15C22A9P

2711-K10C10L1 2711P-B15C22D9P

2711-K10C14 2711P-B15C22A9P

2711-K10C14L1 2711P-B15C22D9P

2711-K10C12
RS-232

2711P-B15C22A9P

2711-K10C12L1 2711P-B15C22D9P

2711-K10C16 RS-232 
(DF1)

2711P-B15C22A9P

2711-K10C16L1 2711P-B15C22D9P

2711-K10C15
ControlNet

2711P-B15C22A9P

2711-K10C15L1 2711P-B15C22D9P

2711-K10C3
DH-485

2711P-B15C22A9P

2711-K10C3L1 2711P-B15C22D9P

2711-K10C9 RS-232 
(DH-485)

2711P-B15C22A9P

2711-K10C9L1 2711P-B15C22D9P

2711-K10C8
DH+

2711P-B15C22A9P

2711-K10C8L1 2711P-B15C22D9P

2711-K10C20
Ethernet

2711P-B15C22A9P

2711-K10C20L1 2711P-B15C22D9P

2711-K10G1
Remote I/O

2711P-B15C22A9P

2711-K10G1L1 2711P-B15C22D9P

2711-K10G10

DeviceNet

2711P-B15C22A9P

2711-K10G10L1 2711P-B15C22D9P

2711-K10G14 2711P-B15C22A9P

2711-K10G14L1 2711P-B15C22D9P

2711-K10G12
RS-232

2711P-B15C22A9P

2711-K10G12L1 2711P-B15C22D9P

2711-K10G16 RS-232 
(DF1)

2711P-B15C22A9P

2711-K10G16L1 2711P-B15C22D9P

2711-K10G15
ControlNet

2711P-B15C22A9P

2711-K10G15L1 2711P-B15C22D9P

2711-K10G3
DH-485

2711P-B15C22A9P

2711-K10G3L1 2711P-B15C22D9P
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1000

2711-K10G9

257 
(10.11)

390 
(15.35)

640 x 480

RS-232 
(DH-485)

2711P-B15C22A9P

290 
(11.42)

418 
(16.46) 1024 x 768

Dual 
Ethernet 
ports

N/A

PanelView Plus 7 
Performance 15 in. 
terminal benefits:
• Higher resolution
• DLR
Communication = 
Ethernet.
Operator input = The 15 in. 
terminal is listed as 
secondary replacement if 
you require a keypad.
Power input = AC or DC.(1)

Conformal coat = Yes(2)

2711-K10G9L1 2711P-B15C22D9P

2711-K10G8
DH+

2711P-B15C22A9P

2711-K10G8L1 2711P-B15C22D9P

2711-K10G20

Ethernet

2711P-B15C22A9P

2711-K10G20L1 2711P-B15C22D9P

2711-T10C1

338 
(13.29)

Remote I/O

No secondary option available.

2711-T10C1L1

2711-T10C10

DeviceNet
2711-T10C10L1

2711-T10C14

2711-T10C14L1

2711-T10C12
RS-232

2711-T10C12L1

2711-T10C16 RS-232 
(DF1)2711-T10C16L1

2711-T10C15
ControlNet

2711-T10C15L1

2711-T10C3
DH-485

2711-T10C3L1

2711-T10C9 RS-232 
(DH-485)2711-T10C9L1

2711-T10C8
DH+

2711-T10C8L1

2711-T10C20
Ethernet

2711-T10C20L1

2711-T10G1
Remote I/O

2711-T10G1L1

2711-T10G10

DeviceNet
2711-T10G10L1

2711-T10G14

2711-T10G14L1

2711-T10G12
RS-232

2711-T10G12L1

2711-T10G16 RS-232 
(DF1)

PanelView Standard 1000 Terminals Secondary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
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1000

2711-T10G16L1

257 
(10.11)

338 
(13.29) 640 x 480

RS-232 
(DF1)

No secondary option available.

2711-T10G15
ControlNet

2711-T10G15L1

2711-T10G3
DH-485

2711-T10G3L1

2711-T10G9 RS-232 
(DH-485)2711-T10G9L1

2711-T10G8
DH+

2711-T10G8L1

2711-T10G20
Ethernet

2711-T10G20L1

(1) AC power is only available on Series A terminals. DC power is only available on Series B terminals.
(2) Conformal coating is available for the DC power, 15 in. combination keypad/touch terminals. To order a terminal that is conformal-coated, add K to the end of a DC-power catalog number; for example, 

2711P-B15C22D9PK.

PanelView Standard 1000 Terminals Secondary Replacement Options  (Continued)

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
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Notes
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PanelView Standard 1400 Terminals Conversions

See the tables in this section for primary and secondary conversions for 
PanelView Standard 1400 terminals.

PanelView Standard 1400 Terminals Primary Replacement Options

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions
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Notes

1400

2711-T14C1

305 
(12.00)

391 
(15.40)

800 x 600

Remote I/O

2711P-T15C22A9P

290 
(11.42)

353 
(13.9)

1024 x 768
Dual 
Ethernet 
ports

2711P-
RAAT15

PanelView Plus 7 
Performance 15 in. terminal 
benefits:
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = only touch.
Power input = only AC.
Conformal coat = No.
Adapter kit is necessary for 
drop-in replacement.

2711-T14C14
DeviceNet

2711-T14C10

2711-T14C12 RS-232

2711-T14C16 RS-232 
(DF1)

2711-T14C15 ControlNet

2711-T14C3 DH-485

2711-T14C9 RS-232 
(DH-485)

2711-T14C8 DH+

2711-T14C20 Ethernet

2711-K14C1

419 
(16.50)

Remote I/O

2711P-B15C22A9P 418 
(16.46)

2711P-
RAAK15

PanelView Plus 7 
Performance 15 in. terminal 
benefits:
• Higher resolution
• DLR
Communication = Ethernet.
Operator input = keypad and 
touch.
Power input = only AC.
Conformal coat = No.
Adapter kit is necessary for 
drop-in replacement.

2711-K14C14
DeviceNet

2711-K14C10

2711-K14C12 RS-232

2711-K14C16 RS-232 
(DF1)

2711-K14C15 ControlNet

2711-K14C3 DH-485

2711-K14C9 RS-232 
(DH-485)

2711-K14C8 DH+

2711-K14C20 Ethernet
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PanelView Standard 1400 Terminals Secondary Replacement Options

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Display 
Resolution Comm. Cat. No.
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Display 
Resolution Comm.

Adapter 
Kit Cat. 
No.

Notes

1400

2711-T14C1

305 
(12.00)

391 
(15.40)

800 x 600

Remote I/O

2711P-T15C21D8S 290 
(11.42)

353 
(13.90) 1024 x 768

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 
15 in. terminal benefits:
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 500
• Max. number of controllers: 1
Communication = Ethernet 
(dual Ethernet ports are 
available).
Operator input = only touch.
Power input = only DC.
Conformal coat = No.

2711-T14C14
DeviceNet

2711-T14C10

2711-T14C12 RS-232

2711-T14C16 RS-232 
(DF1)

2711-T14C15 ControlNet

2711-T14C3 DH-485

2711-T14C9 RS-232 
(DH-485)

2711-T14C8 DH+

2711-T14C20 Ethernet

2711-K14C1

419 
(16.50)

Remote I/O

2711-K14C14
DeviceNet

2711-K14C10

2711-K14C12 RS-232

2711-K14C16 RS-232 
(DF1)

2711-K14C15 ControlNet

2711-K14C3 DH-485

2711-K14C9 RS-232 
(DH-485)

2711-K14C8 DH+

2711-K14C20 Ethernet
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PanelView Enhanced 1000e, 1200e, 1400e Terminals Conversions

See the tables in this section for primary and secondary conversions for 
PanelView Enhanced 1000e, 1200e, 1400e terminals.

PanelView Enhanced 1000e, 1200e, 1400e Terminals Primary Replacement Options

PanelView Standard Terminals PanelView Plus 7 Terminals – Primary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Display 
Resolution Comm.

Adapter 
Kit Cat. 
No.

Notes

1000e

2711E-K10C15

257 
(10.11)

390 
(15.35)

640 x 480

ControlNet

2711P-
T12W22A9P

218 
(8.58)

312 
(12.28) 1280 x 800

Dual 
Ethernet 
ports

2711P-
RAAT12K 
(keyboard)

PanelView Plus 7 
Performance 12.1 in. 
terminals benefits:
• Wide screen has more 

usable screen area
• Higher resolution
• DLR
Communication = 
Ethernet.
Operator input = only 
touch.
Power input = AC.
Conformal coat = No.
Adapter kit is necessary for 
drop-in replacement 
for1000e terminals.

2711E-K10C6 Remote I/O

2711E-T10C15 338 
(13.29)

ControlNet 2711P-
RAAT12 
(touch)2711E-T10C6 Remote I/O

1200e

2711E-K12C6 326 
(12.85)

429 
(16.90)

800 x 600

Remote I/O

2711P-
T12W22A9P

218 
(8.58)

312 
(12.28) 1280 x 800

Dual 
Ethernet 
ports

N/A
2711E-T12C4 316 

(12.50)
318 
(12.50) RS-232

1400e

2711E-K14C15

326.40 
(12.85)

429.30 
(16.90)

800 x 600

ControlNet
2711P-B15C22A9P

290 
(11.42)

353 
(13.9)

1024 x 768
Dual 
Ethernet 
ports

2711P-
RAAK15

PanelView Plus 7 
Performance 15 in. 
terminal benefits:
• Higher resolution
• DLR
Communication = 
Ethernet.
Operator input = keypad 
and touch.
Power input = AC.
Conformal coat = No.
Adapter kit is necessary for 
drop-in replacement.

2711E-K14C6 Remote I/O

2711E-T14C15

390.50 
(15.38)

ControlNet

2711P-T15C22A9P 418 
(16.46)

2711P-
RAAT15 2711E-T14C6 Remote I/O
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Accessories

Some accessories and accessory catalog numbers are new or have changed for 
PanelView Plus 7 Standard and PanelView Plus 7 Performance terminals. See 
the accessories section in the respective user manuals that are listed in 
Additional Resources on page 127 for a list of accessories and catalog numbers 
for the terminals.

Legacy Communication Support

PanelView Plus 7 terminals use only Ethernet communication. If you need 
support for non-Ethernet communication protocols, go to the following 
Encompass™ Partner websites:

• http://www.anybus.com/products/prodindex.shtml 
• http://www.prosoft-technology.com/Products/Gateways 

PanelView Enhanced 1000e, 1200e, 1400e Terminals Secondary Replacement Options 

PanelView Standard Terminals PanelView Plus 7 Terminals – Secondary Replacement Options

Panel Cutout 
Dimensions

Panel Cutout 
Dimensions

Model Cat. No.
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Display 
Resolution Comm.

Adapter 
Kit Cat. 
No.

Notes

1000e

2711E-K10C15

257 
(10.11)

390 
(15.35)

640 x 480

ControlNet
2711P-B15C22A9P 290 

(11.42)
418 
(16.46) 1024 x 768

Dual 
Ethernet 
ports

N/A PanelView Plus 7 
Performance 15 in. 
terminal benefits:
• Higher resolution
• DLR
Communication = 
Ethernet.
Operator input = Keypad 
and touch.
Power input = AC.
Conformal coat = No.

2711E-K10C6 Remote I/O

2711E-T10C15 338 
(13.29)

ControlNet
No secondary option available.

2711E-T10C6 Remote I/O

1200e
2711E-K12C6 326 

(12.85)
429 
(16.90)

800 x 600
Remote I/O 2711P-B15C22A9P 290 

(11.42)
418 
(16.46) 1024 x 768

Dual 
Ethernet 
ports

N/A

2711E-T12C4 316 
(12.50)

318 
(12.50) RS-232 No secondary option available.

1400e

2711E-K14C15

326.40 
(12.85)

429.30 
(16.90)

800 x 600

ControlNet

2711P-T15C21D8S 290 
(11.42)

353 
(13.90) 1024 x 768

One 
Ethernet 
port

N/A

PanelView Plus 7 Standard 
15 in. terminal benefits:
Higher resolution
Application limits:
• Max. screen count: 100
• Max. alarm messages: 

500
• Max. number of 

controllers: 1
Communication = 
Ethernet (dual Ethernet 
ports are available).
Operator input = only 
touch.
Power input = only DC.
Conformal coat = No.

2711E-K14C6 Remote I/O

2711E-T14C15

390.50 
(15.38)

ControlNet

2711E-T14C6 Remote I/O
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Adapter Kit Conversion Table

The adapter kit provides hardware for installing a PanelView Plus 7 
Performance terminal into the cutout of the existing PanelView terminal. See 
the Adapter Kit for PanelView 5500 and PanelView Plus 7 Performance 
Terminals, publication VIEW-IN0002.

IMPORTANT These adapter kits are for PanelView Plus 7 Performance terminals.
Do not install a PanelView Plus 7 Standard terminal with these adapter kits. The bezel of the standard terminal can be 
damaged, which can reduce the effectiveness of the seal and damage the terminal and components that are installed in the 
cabinet.

Adapter Kit Cat. No.
Replace this Existing PanelView Standard or PanelView 
Enhanced Terminal…

With this PanelView Plus 7 Performance Terminal

2711P-RAAT7 N/A 6.5 in. touch screen

2711P-RAAK7 600 terminal, keypad, or keypad with touch screen 6.5 in. keypad with touch screen

2711P-RAAT10 900 terminal, touch screen 10.4 in. touch screen

2711P-RAAK10 900 terminal, keypad 10.4 in. keypad with touch screen

2711P-RAAT12 1000 and 1000e terminals, touch screen 12.1 in. touch screen

2711P-RAAT12K 1000 and 1000e terminals, keypad 12.1 in. touch screen

2711P-RAAT15 1400 and 1400e terminals, touch screen 15 in. touch screen

2711P-RAAK15 1400 and 1400e terminals, keypad 15 in. keypad with touch screen
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Function Key Comparisons

The table provides a comparison of function keys between the PanelView 
Standard and PanelView Plus 7 terminals.

Table 2 - PanelView Plus Replacement Terminals

PanelView Standard 
Terminal

PanelView Plus 7 Replacement Terminal Adapter Kit 
Required

Adapter Kit 
Cat. No.

PanelView Standard 300 or 
300 Micro

None(1) — —

PanelView 550 or 600 touch PanelView Plus 400 keypad or keypad/touch
PanelView Plus 600 touch

No —

PanelView 550 keypad
PanelView 550 keypad/
touch

PanelView Plus 600 keypad or keypad/touch No —

PanelView Plus 400 keypad or keypad/touch
PanelView Plus 600 touch

Yes 2711P-RAK4

PanelView 600 keypad
PanelView 600 keypad/
touch

PanelView Plus 600 keypad or keypad/touch Yes 2711P-RAK6

PanelView Plus 700 keypad or keypad/touch No —

PanelView 900 keypad PanelView Plus 700 keypad or keypad/touch Yes 2711P-RAK7

PanelView Plus 1000 keypad or keypad/touch No —

PanelView 900 touch PanelView Plus 700 touch Yes 2711P-RAT7

PanelView Plus 1000 touch No —

PanelView 1000 keypad PanelView Plus 1000 keypad or keypad/touch Yes 2711P-RAK10

PanelView Plus 1250 keypad or keypad/touch No —

PanelView 1000 touch PanelView Plus 1000 touch Yes 2711P-RAT10

PanelView Plus 1250 touch No —

PanelView 1400 keypad PanelView Plus 1250 keypad or keypad/touch Yes 2711P-RAK12S

PanelView Plus 1500 keypad or keypad/touch No —

PanelView 1400 touch PanelView Plus 1250 touch Yes  2711P-RAT12S           

PanelView Plus 1500 touch No — 

(1) You can replace the PanelView Standard 300 or 300 Micro with a PanelView Plus 400 keypad terminal by increasing the size of 
the current panel cutout.

Table 3 - Function Key Comparisons Between Terminal Platforms

PanelView Standard 
Keypad or Keypad/Touch

PanelView 
Standard 
Function Keys

PanelView 
Plus 7
Function Keys

PanelView Plus 7 Terminal 
Keypad or Keypad/Touch

300M keypad F1…F4

300 keypad F1…F8 F1…F8 400 keypad or keypad/touch

550 keypad or keypad/touch F1…F10 F1…F10 600 keypad or keypad/touch

600 keypad or keypad/touch F1…F10 F1…F10, 
K1…K12

700 keypad or keypad/touch

900 keypad F1…F16 F1…F16, 
K1…K16

1000 keypad or keypad/touch

1000 keypad F1…F16 F1…F20, 
K1…K20

1250 keypad or keypad/touch

1400 keypad F1…F16, 
F17…F21

F1…F20, 
K1…K20

1500 keypad
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Installing a PanelView Plus 7 
Terminal

Optionally install the selected PanelView Plus 7 terminal into the existing 
PanelView Standard panel cutout. You may need an adapter kit depending on 
your terminal selection. 

Refer to Additional Resources on page 127 for a list of applicable 
documentation for your terminal replacement and adapter kit , if necessary.

TIP You can install the terminal after converting and testing your application.
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Import Your Application

Introduction In this chapter, you import your existing PanelBuilder®32 application into 
FactoryTalk® View Machine Edition (ME) software. 

Different software is used by the PanelView™ Standard and PanelView Plus 7 
platforms to develop applications. 

• PanelView Standard terminals run applications that are created with 
PanelBuilder32 software. 

• PanelView Plus 7 terminals run applications that are created with 
FactoryTalk View ME software.

Before You Begin • Review the migration considerations (Chapter 1).
• Select a PanelView Plus 7 terminal replacement and adapter kit, if 

necessary (Chapter 2).
• Optionally install the PanelView Plus 7 terminal replacement 

(Chapter 2). You can install the terminal after migrating and testing 
your application.

What You Need • FactoryTalk View Studio for Machine Edition software with correct 
version for your PanelView Plus 7 terminal. Refer to Required Software 
on page 6 for details.

• PanelBuilder32 .pba application file. 

The application file can reside on your local hard disk drive or external 
storage media:
– Secure Digital (SD) card or USB flash drive for PanelView Plus 7 

terminals.
– USB flash drive for PanelView Plus 7.
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Follow These Steps Follow these steps to import your PanelBuilder32 application into FactoryTalk 
View Machine Edition software.

Import Application Follow these steps to import a PanelBuilder32 application into FactoryTalk 
View Machine Edition software.

1. Launch the FactoryTalk View Studio software.

2. Click the New tab.

Post Conversion Tips

Page 48

Import Application

Page 44
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3. Enter an Application name and click Import.

4. Read the FactoryTalk View dialog box and click OK.

RSLinx® Enterprise software for FactoryTalk View does not need to be 
installed before you import your PanelBuilder32 application.

5. Select PanelBuilder Application (*.pba) and click Next.

6. Select PanelView Terminal (*.pva) if you don’t have the corresponding 
.pba file.
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7. Click the ... button. 

8. Browse to and select your PanelBuilder32 .pba application and click 
Open.

The .pba or .pva file can reside on your local hard disk drive or external 
storage appropriate to your terminal.

9. Click Next.
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10. Configure the import options that are based on your replacement 
terminal.

Click Help at any time for clarification of each option.
a. Check the Convert to new window size checkbox.
b. Select the size (in pixels) of your PanelView Plus 7 terminal display as 

shown in the chart.

c. Check Scale graphic displays.
d. When checked, this setting rescales all displays.
e. If your original PanelView Standard terminal had a touch screen, or 

both a touch screen and keypad, check the box under Touch property 
conversion. 

f. Click the Help button to read the differences between the caption 
alignment options, then select an option for your new application.

g. Click Finish.

Panelview Plus 7 Terminal Resolution (pixels)

PanelView Plus 7 Standard 4 in. (wide) 480 x 272

PanelView Plus 7 Standard 6 in. 640 x 480

PanelView Plus 7 Standard 7 in.
PanelView Plus 7 Performance 7 in.

640 x 480

PanelView Plus 7 Standard 9 in.
PanelView Plus 7 Performance 9 in. (wide)

800 x 480

PanelView Plus 7 Standard 10 in.
PanelView Plus 7 Performance 10 in.

800 x 600

PanelView Plus 7 Standard 12 in.
PanelView Plus 7 Performance 12 in. (wide)

1280 x 800

PanelView Plus 7 Standard 15 in.
PanelView Plus 7 Performance 15 in.

1024 x 768

PanelView Plus 7 Standard 19 in.
PanelView Plus 7 Performance 19 in.

1280 x 1024
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The Importing Project dialog box shows the conversion status. This 
process may take a while, depending on the size of your application. 
When done, you will see the Project Status dialog box in the next step.

11. Review the Project Status dialog box and click OK.

12. Repeat steps 1…11 for each PanelBuilder32 application you want to 
import into FactoryTalk View ME software.

Post Conversion Tips This table lists topics to consider after importing an application.
Table 4 - Post Conversion Tips

Software Feature Description What You Need To Do

Logout button A Logout button that is assigned to a 
function key in a PanelBuilder32 project that 
does not convert properly in the Machine 
Edition application. 

Reassign the function key manually. 

Device shortcuts After importing a PanelBuilder32 .pba 
project, you may not see the newly created 
device shortcuts in the Tag Browser. 

Restart FactoryTalk View Studio software. 
When you reopen the imported 
application, the shortcuts display 
correctly.

Screens When you import PanelBuilder32 projects, 
all screens are minimized.

Nothing

Multistate objects The first state value of PanelBuilder32 
multistate objects is 1.
In Machine Edition software, the first state 
value of multistate objects is 0.

If the imported application contains any 
of these multistate objects, verify the 
state values:
• Control list selector
• List indicator
• Multistate indicator
• Latched push button
• Maintained push button
• Momentary push button
• Multistate push button
• Symbol indicator
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Review the Application Conversion Log

Introduction In this chapter, you review the conversion log generated by FactoryTalk® View 
Machine Edition (ME) software for your imported application. The results of 
this log help you to determine what updates are required in your converted 
application. 

Before You Begin • Review migration considerations (Chapter 1).
• Select a PanelView™ Plus 7 terminal replacement and adapter kit, if 

necessary (Chapter 2). 
• Install the PanelView Plus 7 terminal in the existing PanelView Standard 

panel cutout (Chapter 2).
• Import your PanelBuilder®32 .pba application into FactoryTalk View 

ME software (Chapter 3). 

What You Need • The new name of the application that was imported into FactoryTalk 
View ME software. This action was completed in Chapter 3.

• Conversion log, convert.log, generated by the FactoryTalk View ME 
import wizard.

Follow These Steps Follow this path to review changes that are required to your FactoryTalk View 
ME application.

Open the Conversion Log

Review the Conversion Log

Page 50

About the Conversion Log

Page 50

Page 51
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About the Conversion Log The application conversion log, convert.log, is generated by the import wizard 
when you import your PanelBuilder32 application into FactoryTalk View ME 
software. This log provides detailed information about objects or features that 
did not convert directly from your PanelBuilder32 application. Use this log as a 
guide to update your application accordingly. Modifications to the application 
are required to verify that the application operates correctly in FactoryTalk 
View ME software.

Open the Conversion Log The conversion log, convert.log, is stored with the new application that was 
imported into FactoryTalk View ME software.  

Follow these steps to locate the conversion log on your computer.

1. Navigate to this folder.

C:\Documents and Settings\All Users\Documents\RSView 
Enterprise\ME\HMI projects\

IMPORTANT It is important that you review each object and feature in the converted 
application to verify that they function as expected. Because 
PanelBuilder32 objects or features may not map directly into FactoryTalk 
View ME software, you may need to update your ladder logic to achieve the 
same operational results.

TIP All of your FactoryTalk View ME applications are located in this folder. This 
includes new or imported applications.
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2. Double-click the HMI project folder that contains the new application 
name you created.

You entered this name in the import wizard when importing your 
PanelBuilder32 application  into FactoryTalk View ME software.

3. Double-click the convert.log file that is generated by the import wizard. 

Your convert.log file varies from the example shown.

Review the Conversion Log The conversion log file, convert.log, contains a list of messages including 
warnings, errors, and unsupported features or objects in the converted 
application. You can compare these messages to the messages in the tables for 
information on why the message was logged. For your convenience, the 
message tables are categorized into these groups:

• RSLinx® software
• Tags
• Objects and screens
• Alarms

When resolving conversion log messages, refer to your original PanelBuilder32 
application to review how the objects and tags were used.
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During conversion, all PanelBuilder32 tag names and addresses are converted 
to HMI tags in the FactoryTalk View ME tag database.

Conversion Messages You Can Ignore

Some error messages appear consistently when importing PanelBuilder32 
projects and can be ignored.

RSLinx Messages

This table lists RSLinx messages that may appear in the convert.log file.

IMPORTANT Some features or objects are no longer supported in FactoryTalk View ME 
software. However, new features or objects are available providing the 
same or enhanced functionality. 

Table 5 - Conversion Messages: T o Be Ignored

Error Type Ignore this Error

Startup editor The initial screen does not exist in the graphics list.

Startup editor Failed to get startup information.

Format error File c:\documents and settings\all users\documents\rsview enterprise\me\hmi 
project\app1\import text files\almsg.txt, section/key ’main’

Tags Tags with a bit data type and a scale value of 0 are incorrectly logged during the 
import.

Scale errors Tag scale errors are logged only for analog tags. 

Table 6 - Conversion Log Messages: RSLinx Software

Message Description

RSLinx Topic Converter log file that is created on <date> 
at <time>.
RSLinx2X topics to RSLinx Enterprise shortcuts 
conversion failed. You must manually convert topics to 
shortcuts.

Review the HMI tags in FactoryTalk View ME software 
and note the shortcut name. It is the same as the 
controller name in the PanelBuilder32 application. You 
must use this name when creating the shortcut in 
FactoryTalk View ME software.
For information on creating shortcuts, refer to:
• FactoryTalk View Machine Edition User Guide, 

Volume 1, publication ViewME-UM004, for details 
on creating shortcuts.

• Videos at http://www.rockwellautomation.com/
solutions/integratedarchitecture/resources4.html

RSLinx is not installed. Install the latest RSLinx software 
for proper import. Cannot create instance of RSLinx. Topic 
generation does not succeed.

In FactoryTalk View ME software, configure 
communication and create a shortcut. 
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Screen and Object Conversion Messages

Table 19 lists screen and object messages that may appear in the convert.log file. 
Most of the messages identify these attributes for a FactoryTalk View ME 
object:

• Screen number and name
• Location (x,y) of the object
• New graphic object name

Use this information to locate the object and make required modifications. 
The description for a message may reference a workaround in this document.

Here are some general notes on object conversions:
• Numeric display objects in PanelBuilder32 software are converted to 

Text objects with embedded variables in FactoryTalk View ME software. 
• A Numeric Input Enable button in FactoryTalk View ME software does 

not have a separate display tag. The display value is converted to an 
embedded variable on the Label Tab.

• The Numeric Input Cursor object in FactoryTalk View ME software has 
a separate indicator tag and does not have a Label tab for text.
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Table 7 - Conversion Log Messages: Screens and Objects

Message Description

Message display object is converted to Multistate 
Indicator object at <location>.

A message display in PanelBuilder32 software is the 
same as a multistate indicator in FactoryTalk View ME 
software.

Verify password button at <location> not supported. The Verify Password button is not supported in 
FactoryTalk View ME software.

Select Operator button at <location> not supported. The Select Operator button is not supported in 
FactoryTalk View ME software. 

Screen security settings not converted. Security settings are not converted in FactoryTalk View 
ME software. You must reconfigure all security settings.

String popup is invoked with blank scratchpad on 
<location>.

Verify operation in FactoryTalk View ME software.

Cannot find block write start tag for pilot list selector at 
<location>. The visible state connection is unassigned.

The Piloted Control List Selector in PanelBuilder32 
software does not have a block write tag assigned. 
Assign a block write tag in FactoryTalk View ME software 
if you want a visible state connection.

For LSB support, refer to online help for correct syntax of 
Multistate Indicator’s Value control at <location>. 

FactoryTalk View ME software does support Least 
Significant Bit (LSB) on multistate and list indicators. 
Check the object and make sure that the syntax is correct 
for the value.
The L parameter is used only for message addresses that 
are more than one word in length. See the FactoryTalk 
View online help for information on the L parameter.

Blinking color images are not supported. FactoryTalk View ME software does not support blinking 
color images.

Print Only objects not supported. FactoryTalk View ME software does not support Print 
Only objects.

Line at <location> could not have property set: Width. In FactoryTalk View ME software, lines have a line width 
that is separate from the object location.

Line at <location> could not have property set: Height. In FactoryTalk View ME software, lines have a line height 
that is separate from the object location.

Numeric entry enable button at <location> could not 
have property set: Minimum Value.
Numeric entry enable button at <location> could not 
have property set: Maximum Value.

The Numeric Entry Enable button is converted to a 
Numeric Input Enable button in FactoryTalk View ME 
software. 
• In PanelBuilder32 software, the input and display 

floating point tags shared name and address. The 
min/max values were out of range and could not be 
set in the FactoryTalk View ME object. 

• In FactoryTalk View ME software, set the default min 
and max for floating point. The display value is an 
embedded variable on the 
Label tab.
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Tag Conversion Messages

This table lists tag messages that may appear in the convert.log file.

Alarm Conversion Messages

This table lists alarm messages that may appear in the convert.log file.

For optimal performance, convert PanelBuilder32 alarm tags to direct 
reference tags in FactoryTalk View ME software. Use the L parameter for the 
length in 16-bit words. The alarm trigger type can be bit.

Table 8 - Conversion Log Messages: Tags

Message Description

Invalid characters not supported. Tag has been 
converted to <name>.

FactoryTalk View ME software does not support periods 
in tag names. The periods are converted to underscores.

Already exists in the tag database. The converted tag already exists in the FactoryTalk View 
ME HMI tag database or the conversion created it.

Could not be added to the tag database. Verify that all tag names exist in the FactoryTalk View 
HMI tag database after the conversion. 

The minimum value for this tag was invalid and has 
been set to the minimum value based on the tag’s data 
type.

The minimum value for the tag in the PanelBuilder32 
application is not valid in the FactoryTalk View ME 
application. This discrepancy was corrected.  The 
minimum value for the tag was set according to the tag’s 
data type. Verify that the tag data type and minimum 
value are correct.

The maximum value for this tag was invalid and has 
been set to the minimum valid value based on the tag’s 
data type.

The maximum value for the tag in the PanelBuilder32 
application is not valid in the FactoryTalk View ME 
application. This discrepancy was corrected. The 
maximum value for the tag was set according to the 
tag’s data type. Verify that the tag data type and 
maximum value are correct.

The scale for this tag was invalid and has been set to its 
default value.

Verify that the scale for the tag data type is correct.

Tag converted to memory tag, as its addressing syntax is 
not supported.

For this specific instance, an RIO bit array data type with 
a length of 2 is using output O:xxx address.  
In the converted application. FactoryTalk View ME 
software does not support bit arrays. Bit arrays are 
converted to memory tags.

Tag converted to memory tag, as its address is blank. The tag was converted to a memory tag because the tag 
address was blank in the PanelBuilder32 software.

The array size for this tag was invalid and has been set to 
the maximum supported size.

The character array size was converted to the maximum 
string length of 82 in the FactoryTalk View ME 
application.

Bit array tags are not supported. Tag will be converted as 
a memory tag.

FactoryTalk View ME software does not support the bit 
array data type. Typically, bit arrays were used in 
PanelBuilder32 software for addresses less than one 
word in length. 
In FactoryTalk View ME software, change the tag address 
to a full word address. When you use non-Remote I/O 
addresses, these conversions take place:
• Bit array is converted to an analog, default type 

Device tag with a word length as opposed to a 
memory tag.

• BOOL is converted to a bit tag.
• DINT is converted to an analog, long integer tag.
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See the FactoryTalk View online help for information on the word length 
L parameter.

Table 9 - Conversion Log Messages: Alarms

Message Description

Bit and LSBit triggered alarms that used a trigger tag 
with a bit data type will only be able to trigger a single 
alarm after import.

See Alarm Trigger Tags on page 8 for details on alarm 
tag data types. 

Alarm message Ack option not supported. In PanelBuilder32 software, the alarm ACK is on an 
individual message. FactoryTalk View ME software does 
not support individual acknowledgement of alarms. The 
alarm Ack is on the triggers. 

Alarm List at <location> displays all alarms. This message describes the type of alarm list.

Alarm List at <location> displays all active alarms. This message describes the type of alarm list.

Alarm List at <location> will display all alarms that 
have come out of alarm.

This message describes the type of alarm list.

Alarm List at <location> does not support displaying 
alarms that do not require acknowledgement.

This message describes the type of alarm list.

“Remote Clear All Alarm Tag” alarm control not 
supported.

FactoryTalk View ME software does not support this 
alarm tag.

“Remote Clear All Alarm Handshake Tag” alarm control 
not supported.

FactoryTalk View ME software does not support this 
alarm tag.

Tag converted to memory tag, as its address is blank. The tag was converted to a memory tag because the tag 
address was blank in PanelBuilder32 software.

The array size for this tag was invalid and has been set to 
the maximum supported size.

The character array size was converted to the maximum 
string length of 82.

Bit array tags are not supported. Tag will be converted as 
a memory tag.

FactoryTalk View ME software does not support the bit 
array data type. Typically, bit arrays were used in 
PanelBuilder32 software for addresses less than one 
word in length. 
In FactoryTalk View ME software, change the tag address 
to a full word address. When using non-Remote I/O 
addresses, these conversions take place:
• Bit array is converted to an analog, default type 

device tag with a word length as opposed to a 
memory tag.

• BOOL is converted to a bit tag.
• DINT is converted to an analog, long integer tag.
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Review Object Mapping

Introduction In this chapter, you review how objects and alarms from PanelBuilder®32 
software map to FactoryTalk® View Machine Edition (ME) software.

Before You Begin • Review migration considerations (Chapter 1).
• Select a PanelView™ Plus 7 terminal replacement and adapter kit, if 

necessary (Chapter 2).
• Optionally install the PanelView Plus 7 terminal in the existing 

PanelView Standard panel cutout (Chapter 2).  
• Import your PanelBuilder32 .pba application into FactoryTalk View ME 

software (Chapter 3).
• Review the conversion log for your imported application (Chapter 4).

What You Need Conversion log generated by the FactoryTalk View ME Import Wizard for the 
imported application.

Follow These Steps Follow these steps to review how PanelBuilder32 objects and alarms map to 
FactoryTalk View ME software. This information helps you correct 
application errors that are listed in the conversion log.

Reviewing Object Mapping

Page 58

Reviewing Data Type 
Mapping

Page 58

Reviewing Mapping of 
Communication Networks

Page 59
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Reviewing Object Mapping This table identifies how some PanelBuilder32 graphic objects migrate into a 
FactoryTalk View ME application.

Reviewing Data Type 
Mapping

This table shows how data types map between PanelBuilder32 and Machine 
Edition software.

IMPORTANT It is important that you verify the function of all objects after importing 
your application to FactoryTalk View ME software. New objects may not 
function as expected.

Table 10 - Object Mapping

This PanelBuilder32 object Maps to this FactoryTalk View ME object

Message Display Multistate Indicator

Numeric Entry Cursor Point Numeric Input Enable

Increment/Decrement Entry Numeric Input Enable

ASCII Entry Cursor Point String Input Enable

Numeric Display Text object with numeric embedded variable

Connected Line Polyline

Circle Ellipse

Freeform Freehand

Bar Graph and Gauge Inner Text Bar Graph with separate Text object

Bar Graph and Gauge Inner Graphic Bar Graph with separate Image object

Gauge Needle Separate Gauge object. 
For example, in PanelBuilder32 software, a Gauge object is 
configured with two needles. This object is converted to two separate 
Gauge objects in Machine Edition software.

Table 11 - Data Type Mapping

PanelBuilder32 Data Types Machine Edition Data Types

Bit Digital

Bool Digital

Char array String (82 character max)

Unsigned integer Unsigned

Signed integer Int

IEEE Floating Point (FP)

4BCD 4BCD

none 3BCD

none Byte (unsigned 0…255)

Bit array None

DINT Long Int (signed 32 bit)

SINT (8 bit signed) None
58 Rockwell Automation Publication 2711P-AP006E-EN-P - August 2022



           Chapter 5
Reviewing Mapping of 
Communication Networks

This table shows communication protocols that are supported by 
PanelBuilder32 and FactoryTalk View ME applications.

Table 12 - Mapping of Communication Networks

PanelBuilder32 
Communication Protocols

FactoryTalk View ME Communication 
Protocols

RS-232 (DF1) RS-232 (DF1)

RS-232 (DH-485) RS-232 (DH-485)

DH-485 DH-485

DH+™ DH+ 
Does not support nodes that use the 
AutoMax® node type

EtherNet/IP
– EtherNet/IP controller address
– EtherNet/IP CIP
– Assembly object

EtherNet/IP
– Supported
– Not supported
– Not supported

RIO RIO (1)

(1) Remote I/O and DeviceNet communication modules are not available for 
PanelView Plus 6 terminals.

DeviceNet Not supported (1)

ControlNet ControlNet

KEPWare communication drivers for third-
party controllers
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Notes:
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Review Unsupported Features

Introduction In this chapter, you review unsupported features in FactoryTalk® View Machine 
Edition (ME) software. This review helps you resolve errors in the imported 
application.

Before You Begin • Review migration considerations (Chapter 1).
• Select a PanelView™ Plus 7 terminal replacement and adapter kit, if 

necessary (Chapter 2).
• Optionally install the PanelView Plus 7 terminal in the existing 

PanelView Standard panel cutout (Chapter 2).
• Import your PanelBuilder32 .pba application into FactoryTalk View ME 

software (Chapter 3).
• Review the conversion log for your migrated application (Chapter 4).
• Review object mapping (Chapter 5).

What You Need Conversion log generated by the FactoryTalk View ME import wizard for the 
imported application.

Follow These Steps Follow this path to review unsupported features in FactoryTalk View ME 
software.
 

Reviewing Unsupported 
Objects

Reviewing Unsupported Tags 
and Controls

Page 62

Page 62

Reviewing Unsupported 
Features

Page 62
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Reviewing Unsupported 
Objects

These PanelBuilder®32 objects are not supported in FactoryTalk View ME 
software:

• Print Only
• Circular Scale
• Scrolling Text
• Print Alarm Button
• Horn Silence Button and Lamp/Horn Test Button
• Select Operator Button
• Enable/Disable Security Button
• New Password Button 
• Verify Password Button

Reviewing Unsupported Tags 
and Controls

These PanelBuilder32 controls are not supported in Factory Talk View ME 
software:

• Remote Ack All Handshake tag
• Remote Clear All Alarm tag
• Remote Clear All Alarm Handshake tag
• Message to Remote Device Notification tag
• Message to Remote Device Handshake tag
• Ack setting for alarms
• Bit alarm acknowledgement
• Handshaking for alarms that are sent to a remote device

Reviewing Unsupported 
Features

Some PanelBuilder32 features are not supported in FactoryTalk View Machine 
Edition software. Compare the conversion log with the information on 
unsupported features to assist with updates to your imported application. 
Additional information is provided where possible to achieve the same 
functionality by using another option or workaround in your imported 
application.

Table 13 - Unsupported Features in FactoryTalk View Machine Edition

Unsupported Feature Object Additional Information

Blink Text 
Arc Ellipse 
Line 
Panel
Rectangle 
Wedge

In FactoryTalk View ME software, all list 
objects use color animation to blink.

Image Color images do not blink. 
Monochrome images use the Blink property 
to enable blinking.

Allow Home/End
Allow Wrap
Ramping by Coarse Steps

Increment/Decrement Entry 
Button (Converted to Numeric 
Input Enable Button)

The Increment/Decrement Entry button is 
converted to a Numeric Input Enable button 
in FactoryTalk View ME software.
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Print Setting Multistate Indicator
Message Display

Printing Print Only Object This object is not supported in FactoryTalk 
View ME software.

Initial State Values Maintained Push button
Multistate Push button
Standard Control List Selector

To set the states of these objects on 
application startup, create a macro to set 
the appropriate tag values for the object 
controls. Assign the Macro in the Startup 
editor of FactoryTalk View ME software.

Least Significant Bit data format Multistate Indicator
Message Display
List Indicator
Standard Control List Selector

Bit triggered states are not supported in 
FactoryTalk View ME software. Modify the 
state values and the read tag, or assign an 
expression to return the value of the Least 
Significant Bit.

Inner Text and Inner Graphic Bar Graph
Gauge

In FactoryTalk View ME software, the Inner 
Text is converted to a separate Text object. 
The Inner Graphic is converted to a separate 
Image object.

Scale Clipping Gauge If the scale doesn’t fit within the height or 
width of the gauge, it is not clipped. Check 
the position of the scale to make sure it 
doesn’t overlap other objects.

Needle Gauge In FactoryTalk View ME software, each 
needle is converted to a separate Gauge 
object.

No Acknowledgement Alarm List In FactoryTalk View ME software, all alarms 
can be acknowledged.

Ack Setting Alarm messages In FactoryTalk View ME software, all alarms 
can be acknowledged.

Turn Object View On property All objects If this property is set to False, the converted 
object does not appear.

Embedded Variable Numeric Display Numeric Display objects are converted to 
Text objects with embedded variables.

Foreground and background colors All objects The foreground and background colors of 
PanelBuilder32 objects are used to set the 
Selection Fore and Selection Back color for 
FactoryTalk View ME objects. 
If the foreground and background colors are 
the same, the Selection Fore and Back 
colors are also the same. This color status 
means that the selected state is invisible, 
because the foreground color (text) and the 
background color are the same. 
To make the selected state visible, edit the 
object to change either the Selection Fore 
or Selection Back color.

Selected state visibility during 
design time and runtime

List Indicator
Display List Selector
Control List Selector
Piloted Control List Selector
Alarm List Selector

If the original Foreground Color (text) and 
Background Color of the object are the 
same, the selected state is invisible. To 
make the selected state visible, edit the 
object to change either the Selection Fore 
or Selection Back color.

Table 13 - Unsupported Features in FactoryTalk View Machine Edition

Unsupported Feature Object Additional Information
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Caption and image placement All objects FactoryTalk View ME software supports one, 
three, or nine positions for captions and 
images, depending on the type of object. 
On conversion, captions and images are 
positioned using the closest match. Some 
captions might do the following:
• Overlap images
• Get truncated
• Get clipped to fit the object
Realign or resize objects for best fit.

Goto Configure Mode Button Object not converted

Security Enable/Disable Security 
Button
New Password Button
Verify Password Button

In the PanelBuilder32 software, user 
passwords are create in the Configuration 
mode screens. FactoryTalk View ME 
software requires the Change Password 
button on a display.

Security Settings FactoryTalk View ME software uses a 
different method to assign security to 
graphic displays. 
You must reconfigure security. Once logged 
on, the operator does not need to reenter 
the password until manually logged off, or 
optionally after an idle time. 

Table 13 - Unsupported Features in FactoryTalk View Machine Edition

Unsupported Feature Object Additional Information
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Qualify the Runtime Application

Introduction In this chapter, you qualify the integrity of your converted application before 
downloading and running it in your production environment. Because you are 
using different software with new features and functionality, it is important to 
validate the application for proper operation.

Before You Begin • Review migration considerations (Chapter 1).
• Select a PanelView™ Plus 7 terminal replacement and adapter kit, if 

necessary (Chapter 2). 
• Optionally install the PanelView Plus 7 terminal in the existing 

PanelView Standard panel cutout (Chapter 2). 
• Import your PanelBuilder32 .pba application into FactoryTalk® View 

ME software (Chapter 3). 
• Review the conversion log for your migrated application (Chapter 4).
• Review object mapping (Chapter 5).
• Review unsupported features (Chapter 6).

What You Need Converted FactoryTalk ME application.
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Follow These Steps Follow these steps to configure diagnostics, validate, test run, configure global 
memory connections, download, and run your converted application on a 
PanelView Plus 7 terminal.

Review Diagnostic Lists On your development computer, FactoryTalk View ME software features a 
diagnostic list at the bottom of the application window. You can configure 
FactoryTalk diagnostics to display information, warnings, and errors during 
application development and runtime. 

When you test run your application, the diagnostic list displays messages and 
errors that are logged by the application. Use this list to identify the graphic 
objects or features that generated the messages or errors. Correct these errors 
during the validation process. 

Review Diagnostic Lists

Configure the Runtime 
Diagnostic Display

Page 66

Page 67

Review Error States for 
Graphic Objects

Page 69

Configure Communication

Page 70

Test Run the Application

Page 74

Page 72

Test Run Graphic Displays
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The diagnostic lists let you clear one or all messages in the list:
• Click the Clear button to delete the message that is displayed. 

If you resize the list to display multiple messages, select a message and 
then click Clear.

• Click the Clear All button to delete all messages in the list.
 

To view this diagnostic information during runtime, use either of the 
following:

• Default [DIAGNOSTICS] graphic display
• Diagnostic list object in a customized graphic display 

Configure the Runtime 
Diagnostic Display

Follows these steps to configure the default [DIAGNOSTICS] display to log 
errors or warnings that are generated during runtime operation.

1. Launch FactoryTalk View ME software if not open.

2. Open your converted application.

3. Expand the System folder in your application Explorer window.

4. Double-click Diagnostic List Setup.

5. Under Runtime display, verify that [DIAGNOSITICS] is the Display 
name.

This display is the default diagnostic display that pops up during 
runtime when configured events occur.

TIP The [DIAGNOSTICS] display is in the Libraries editor of the application 
Explorer window if not already included in your application displays. 
Import the [DIAGNOSTIC] display if you are going to use it.
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6. Check the boxes next to the messages that you want to appear in the 
display when events occur during runtime.

It is recommended that you always log errors and warnings during 
runtime. 

For information on how each dialog option is designed to function 
during runtime, click Help.

7. Click OK.
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Review Error States for 
Graphic Objects

In FactoryTalk View ME software, error conditions for visible objects may be 
different than the error conditions in PanelBuilder®32 software. The table 
clarifies what happens when errors occur for objects when tags are unavailable 
or communication is lost. 

For additional information on objects, refer to the FactoryTalk View Machine 
Edition online help.

Table 14 - Error Modes for Objects

Graphic Object Visible Error Mode

• Momentary Push Button
• Maintained Push Button
• Latched Push Button
• Multistate Push Button

The caption displays ‘default error message’ for the error 
state.

• Interlock Push Button
• Ramp Push Button

No visible error message or error condition is displayed.
When you click these objects, an error message is 
generated and logged to the diagnostic list object.

• Numeric Display
• Numeric Input Cursor

These objects display asterisks,  ******.

• Numeric Input Enable
• String Input Enable
• String Display

No visible error message or error condition is displayed.
When you click these objects, an error message is 
generated and logged to the diagnostic list object.

• Goto Display Button
• Return To Display Button
• Display List Selector
• Close Display Button

No visible error message or error condition is displayed.
If communication to the PLC controller is lost, these 
buttons still let you navigate through your application.

Multistate Indicator The caption displays Error for the error state.

Symbol Properties The object shows the image color that is defined in the 
error state.

List Indicator No visible error message or error condition is displayed.

Bar Graph Gauge This object shows a transparent wireframe box.

Scale No visible error message or error condition is displayed.

Local Message Display This object displays question marks,  ???????, in the error 
state.

• Backspace
• End
• Enter
• Home
• Move Left
• Move Right
• Move Down
• Page Up
• Page Down

No visible error message or error condition is displayed.

• Sort Alarm
• Reset Alarm
• Alarm Banner
• Alarm Status List

No visible error message or error condition is displayed.

Display Print No visible error message or error condition is displayed.

Trend This object appears not to have any pens and does not 
perform real time trending.

Time and Date No visible error message or error condition is displayed.
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Configure Communication You are now ready to configure communication for your imported application. 
Because this application is a new application, a communication configuration 
does not exist. The configuration varies depending on the communication 
protocol you use.

Follow these steps to configure communication for your application.

1. In the Explorer window, expand RSLinx® Enterprise and double-click 
Communication Setup.

2. Select Create a New Configuration and click Finish.

3. In the Communication Setup dialog box, select the Local tab.

This communication path is used for testing individual displays and Test 
Application.
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4. Select the driver that you are using in your design environment to test 
communication. 

Browse to the controller device and configure local communication.

5. Select the Target tab.

This communication path is used on the PanelView Plus to 
communicate to the controller in your runtime application in Chapter 8.

6. Right-click RSLinx Enterprise and select Add Driver.

7. Select the appropriate driver and click OK.
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8. Configure the driver properties.

ControlNet Communication

See ControlNet Communication for PanelView Plus 7 Terminals user manual, 
publication, 2711P-UM003, for step-by-step details on how to configure 
ControlNet Scheduled and Unscheduled communication with FactoryTalk 
View ME software. 

Test Run Graphic Displays FactoryTalk View ME software provides a Test Display mode to test the 
animation and assigned tags that are connected to objects in a graphic display. 
Any information, warning, or errors are logged to the diagnostic list for your 
review.

Test Display mode tests all objects in a display:
• Button objects
• Numeric and string objects to verify that correct values are displayed
• Objects that require user input
• Objects that use animation

For each object tested, review and correct any errors and warnings that are 
logged to the diagnostic list. Retest the display object before proceeding to the 
next object.

TIP Remote I/O and DeviceNet communication modules are not supported by 
the PanelView Plus 7terminals.
PanelView Plus Compact 400, 600, and 1000 terminals are fixed hardware 
configurations that do not support communication modules.

For On This Terminal + Communication Module Select

DH+™ PanelView Plus 6 (700...1500)(1) + 2711P-RN6 or 2711P-RN6K DH+ (1784-PKTX, 2711P-RN6, 2711P-RN8)

PanelView Plus 400 or 600 + 2711P-RN8 DH+ (1784-PKTX, 2711P-RN6, 2711P-RN8)

DH-485 PanelView Plus 6 (700...1500)(1) + 2711P-RN6 or 2711P-RN6K DH-485 (1784-PKTX, 2711P-RN6)

PanelView Plus 400 or 600 + 2711P-RN3 Serial DH-485 (including 2711P-RN3, 2711P-RN22C)

ControlNet PanelView Plus 6 (700...1500)(1) + 2711P-RN15S or 
2711P-RN15SK

ControlNet (1784-PCIC, 1784-PCICS, 2711P-RN15S) or
ControlNet (1784-PKTCS, 2711P-RN15S, 2711P-RN15C)

PanelView Plus 400 or 600 + 2711P-RN15C ControlNet (1784-PKTCS, 2711P-RN15S, 2711P-RN15C)

(1) Also applies to PanelView Plus 700 to 1500 terminals running FactoryTalk View Machine Edition Firmware Revision 5.1 or earlier.

IMPORTANT You must be connected to the controller and online before test running the 
display or all objects show their error states.

IMPORTANT In Test Display mode, objects in the display are activated and connected to 
assigned tags. Only tags connected to objects in the display work. Links to 
other displays or alarms, including data logging, macros, global connections, 
and information messages do not work. 
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Follow these steps to activate Test Display mode for a display and then return 
to Edit mode. Running Test Display mode and correcting logged errors in Edit 
mode is an iterative process. 

1. Open the display that you want to test.

2. Access Test Display mode in one of two ways.
• Choose Test Display from the View menu.

• Click the Test Display button on the toolbar. 

3. Return to Edit mode in one of two ways.
• Choose Edit Display from the View menu.

• Click the Edit Display button on the toolbar.
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Test Run the Application After testing and verifying that each graphic display is error free, you are ready 
to test run the entire application. Application Test mode lets you navigate 
through the entire application to validate functions that are not tested in 
Display Test mode. Some of these features include alarming, data logging, 
information messages, global connections, and macros.

As you navigate through displays in Application Test mode, the Diagnostic List 
logs warnings and errors as they occur. Correct all logged errors and then retest 
the application to validate error correction. 

Follow these steps to test run an application.

1. Open your converted application in FactoryTalk View ME software.

2. Test the application in one of two ways.
• Choose Test Application from the Application menu.

• Click the Test Application icon on the toolbar.

The emulator opens on your computer and runs the application. There 
is a two-hour limit for using the runtime emulator.

3. To exit the emulator, press x on your keyboard.

IMPORTANT You must be connected to the controller and online before testing the 
application for accuracy.

TIP Local messages and graphic objects that are configured for multiple 
languages display in the current language of the application while in Test 
Application mode.

TIP The emulator window requires focus when pressing the x key to exit the 
emulator.
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Create the Runtime Application

Introduction In this chapter, you create, download, and run the converted application with 
all modifications on the PanelView™ Plus 7 terminal.

Before You Begin • Review migration considerations (Chapter 1).
• Select a PanelView Plus 7 terminal replacement and adapter kit, if 

necessary (Chapter 2). 
• Optionally install the PanelView Plus 7 terminal in the existing 

PanelView Standard panel cutout (Chapter 2). 
• Import your PanelBuilder32 .pba application into FactoryTalk® View 

ME software (Chapter 3). 
• Review the conversion log for your migrated application (Chapter 4).
• Review object mapping (Chapter 5).
• Review unsupported features (Chapter 6).
• Qualify the runtime application (Chapter 7).

What You Need • Converted FactoryTalk View ME application.
• Qualified runtime application.
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Follow These Steps Follow these steps to create a runtime application, download, and run the 
application on the PanelView Plus 7 terminal.

Create the Runtime 
Application

Download the Runtime 
Application

Page 77

Page 78

Run the Application

Page 85
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Create the Runtime 
Application

Follow these steps to create a runtime application file from your converted 
Machine Edition .mer file.

1. Open your converted application in FactoryTalk View ME software.

2. Choose Create Runtime Application from the Application menu.

3. Enter a name for your runtime application or accept the default name. 

4. Click Save to create the runtime file.

The file is saved to the default runtime location.

A dialog box shows the status of the runtime file creation. When the 
process completes, the dialog box automatically closes.
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Download the Runtime 
Application

You can download your runtime .mer application to a PanelView Plus 7 
terminal by using an Ethernet connection or external storage device that is 
supported by your terminal. 

Download Application Using Ethernet Connection

Follow these steps to download your runtime application to the PanelView 
Plus 7 terminal by using an Ethernet connection.

1. Establish an Ethernet connection between your computer and the 
terminal.

2. Launch the transfer utility in one of two ways.
a. Choose Transfer Utility from the Tools menu.
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b. Click the appropriate tool on the toolbar.

3. To browse for the runtime file that you just created, click the ... button.
FrameMaker v2019.2.2 May 
2020

4. Select the runtime file that you just created and click Open.

5. Under Select destination terminal, expand the Ethernet driver.

6. Browse for and select your PanelView Plus 7 terminal.
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7. Click Download to download the runtime file to the PanelView Plus 7 
terminal.

A progress bar shows the status of the download.

s
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8. Click OK when the download has completed successfully.

9. On the PanelView Plus 7 terminal, load the application by pressing the 
Load Application button or pressing the [F1] function key.

10. Select your runtime application.
a. Press the up or down cursor to select the application if multiple 

applications exist.
b. Press the Load button or the [F2] function key on terminal.

PVs_App.mer
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11. Press Yes or the [F7] function key on terminal to replace the 
communication settings in the terminal with the settings in your 
runtime application.

You are now ready to run the application on the terminal. Skip to page 85.

Download Application Using External Storage

Follow these steps to load the runtime application on the PanelView Plus 7 
terminal by using an external storage card.

1. On your computer, copy the runtime application file to the runtime 
folder on a storage card that is supported by the terminal.

2. Turn off power to the terminal.

Table 15 - External Storage Media

This Terminal Platform Supports This External Storage

PanelView Plus 7 Secure Digital (SD) card, cat. no. 1784-SDx

USB flash drive on USB host ports

IMPORTANT The root of the CompactFlash card must have the path  
‘RockwellSoftware\RSViewME\Runtime’ or the application file is not 
recognized at runtime.
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3. Load the storage card into the card slot of the terminal.

4. Turn on power to the PanelView Plus 7 terminal.

5. On the configuration display, press Load Application or the [F1] 
function key on the terminal.

CompactFlash Card Slot on 
PanelView Plus 700 and 1500 
terminals that support FactoryTalk 
View Machine Edition software 
version 5.1 or earlier.

SD Card Slot and USB Host Port on PanelView Plus 6  Terminals

SD Card Slot

USB Host Ports
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6. To select External Storrage 1 or 2, press the Source button or [F1] on the 
terminal.

7. Select your runtime application.
c. To select the application (if multiple applications exist), press the up 

or down cursor.
d. Press the Load button or [F2] function key on the terminal.

8. To replace the communication settings in the terminal with the settings 
in your runtime application, press Yes or the [F7] function key on the 
terminal.

PVs_App.mer
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Run the Application Follow these steps to run your application on a PanelView Plus 7 terminal. 

1. To run the currently loaded application, press Run Application or the 
[F2] function key on the terminal.

2. Cycle through all runtime displays continuously. 

PVs_App.mer

IMPORTANT If your application is not communicating to the controller:
• Check all cable connections.
• Verify that the Target tab in the RSLinx® Enterprise Communication 

Setup is configured correctly.
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Notes:
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Optimize Runtime Performance

Introduction In this chapter, you learn how to benchmark performance of your runtime 
application so that you can optimize as needed.

Before You Begin • Review migration considerations (Chapter 1).
• Select a PanelView™ Plus 7 terminal replacement and adapter kit, if 

necessary (Chapter 2). 
• Optionally install the PanelView Plus 7 terminal in the existing 

PanelView Standard panel cutout (Chapter 2). 
• Import your PanelBuilder32 .pba application into FactoryTalk® View 

ME software (Chapter 3). 
• Review the conversion log for your migrated application (Chapter 4).
• Review object mapping (Chapter 5).
• Review unsupported features and common migration issues 

(Chapter 6).
• Correct, validate, and test the application (Chapter 7).
• Create, download, and run the application on a PanelView Plus 7 

terminal (Chapter 8).

What You Need • A converted FactoryTalk View ME runtime application file that is 
downloaded and loaded in your PanelView Plus terminal. 
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Follow These Steps Follow this path to benchmark and optimize the performance of your 
converted application.

Benchmarking Performance You are now ready to compare performance of your PanelBuilder®32 
application running on a PanelView Standard terminal and the converted 
FactoryTalk View ME application running on a PanelView Plus 7 terminal. 

You perform the benchmarking by functional areas so that you can optimize 
performance one step at a time. Each function may also provide alternative 
methods to improve performance where needed.

Reviewing Tag Update Rate

Measure Performance of 
Display Changes

Page 89

Page 90

Reviewing Background 
Updates

Page 91

Benchmarking Performance

Page 88

Optimize Tags for Network 
Performance

Page 92

IMPORTANT Performance benchmarking between the terminal platforms is critical so 
that operators experience the same, if not better, performance on the new 
platform. 
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Reviewing Tag Update Rate The tag update response is dependent on where the tag is used in the 
application. Each display or feature has a maximum tag update rate. This 
parameter specifies the maximum rate at which new data is updated on the 
display, including tags used in expressions and embedded variables. 

The default tag update rate is 1.0 second. 
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Measure Performance of 
Display Changes

During performance benchmarking, you may want to measure the time it takes 
for the application to change from one display to another. It is important that 
the operator experiences the same display feedback, if not better, on the 
PanelView Plus 7 terminal. 

If possible, place your PanelView Standard terminal and the new PanelView 
Plus 7 terminal side by side. Run the original PanelView Standard application 
and the converted PanelView Plus 7 application simultaneously.

Follow these steps to measure the length of time it takes to change from one 
display to another in the application. 

1. Load and run your converted application on the PanelView Plus 7 
terminal.

2. To record the time it takes to change from one display to another display, 
use a stopwatch in the next steps.

3. On any display, press the button that results in a display change and start 
recording the time.

4. Stop recording the time after all tag information is loaded on the next 
display.

5. Repeat steps 3 and 4 until you have recorded the times for all displays in 
the application.

6. If possible, repeat this procedure for the same application on the 
PanelView Standard terminal. 

In a FactoryTalk View ME application, each display can have a maximum of 
1000 tag connections assigned. The more tag connections a display has, the 
longer it takes to load the display.

If performance is slower for some displays in the PanelView Plus 7 application, 
you can do one of the following:

• Adjust the maximum tag update rate for these displays
• Reduce the number of tags that are used on these displays

IMPORTANT Cycle through all displays at least twice. The first time that you open a 
display it loads slower than subsequent displays because tag information is 
cached into memory after a display is opened.
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Reviewing Background 
Updates

Background tags are continuously updated by the runtime application whether 
or not the operator is on a specific display. Tags update according to the 
maximum tag update rate for the associated feature.

The more familiar you are with these tags and features, the easier it is to update 
and fine tune your application.

Global Connections

The Global Connections editor provides a list of connections that you can 
assign to tags:

• Date and Time
• Display
• Macro
• Backlight
• Memory

These tags are continuously updated in the background by the application, 
regardless of what display is active. The tags update according to the setting of 
the maximum update rate parameter.

TIP Set noncritical tags to a longer maximum update rate. Set critical tags to a 
lower rate so that time-sensitive information is always available to the 
operator.
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Alarms

The Alarm Setup editor lets you define triggers, messages, and advanced 
features for alarms. Any trigger tags or optional connections that are assigned 
within the editor update according to the maximum update rate. This 
parameter is on the Advanced tab.

Information Messages

The Information Message editor lets you specify information messages to 
automatically display on a user-defined display. The tags that are assigned in 
this editor, update at the rate defined by the maximum update rate.

Optimize Tags for Network 
Performance

You can further improve network performance by converting the application 
tags from HMI tags to direct reference tags.
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The tag converter wizard (TCW) automatically converts tags in an application 
from HMI tags to direct reference tags.

About the Tag Converter Wizard 

The tag converter wizard (TCW) requires information from an existing 
application to perform the conversion:

• Exported HMI tag database
• Exported displays (xml format)
• Exported alarms (xml format)

When this pre-conversion information is available, you can run the wizard. 
The wizard examines the HMI tag database to determine which tags to convert 
to alias tags or direct reference tags.

Remote I/O Applications

The HMI tags are substituted with the alias or device tags in the display and 
alarm xml files. When the conversion is done, a Convert_Log.txt file is 
generated. This file indicates all tag substitutions on a display-by-display basis. 
A new set of display and alarm xml files are created that you can import into 
your migrated application. The original display and alarm xml files are 
unaltered.

Non-Remote I/O Applications

For all non-Remote I/O applications, HMI tags are converted to direct 
reference tags regardless of scale, offset, and min/max values. This conversion 
includes Ethernet, DF1, DH+™, and DH-485 applications.

TIP You can download The TCW utility from the Knowledgebase. 
See Technote 31289.

IMPORTANT The tag converter wizard converts HMI tags to device tags. It does not 
convert device tags to HMI tags. Back up your application before starting 
the conversion. The conversion alters the original displays when imported 
into your new application.

IMPORTANT For Remote I/O applications, HMI tags that use custom scale and offsets are 
not converted. Any alias tags with initial values assigned are not converted. 
You must manually set the custom scale, offsets, and initial values for these 
tags, for objects to operate correctly.

IMPORTANT Memory tags are not converted. You must convert memory tags manually 
before running the Tag Converter Wizard.
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The TCW does not add the L parameter to alarm trigger tags. See page 8 for 
details on converting alarm trigger tags to direct reference.

Export the HMI Tag Database

Follow these pre-conversion steps to export the HMI tag database in your 
migrated application.

1. Launch FactoryTalk View Studio software.

2. Select your ME application and click Open.

This example selects Baggage_800x600.

1
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3. Choose Tools>Tag Import and Export Wizard from the Tools menu.

4. In the Operation field, select Export FactoryTalk View tag database to 
CSV files and click Next.

5. Click the ... button and browse to the project .med file and click Next.

This example uses Baggage_800x600.med.

6. Accept the default name for the destination file.

Export FactoryTalk View tag database to CSV files
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7. Click Finish.

You have successfully exported the HMI tag database.

The default destination of the .csv file is:

C:\Documents and Settings\All Users\Documents\RSView 
Enterprise\ME\HMI Projects\Project_Name\Project_Name-Tags.CSV
96 Rockwell Automation Publication 2711P-AP006E-EN-P - August 2022



           Chapter 9
Export Graphic Displays to XML File

Follow these pre-conversion steps to export the graphics display in your 
converted application to an xml format.

1. Navigate back to the open instance of the FactoryTalk View Studio 
software.

2. In the Application Explorer, right-click Displays and choose Import and 
Export.
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3. Select Export graphic information from displays and click Next.

4. Click Select All, then Next.

5. Click the ... button.

6. Create a folder anywhere on your computer named Exported Displays.
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7. Click Finish.

A dialog box shows the name of each graphic display as it is exported to 
an .xml file.
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8. Review the Display_Export.txt file for any errors that are generated 
during the export.

The displays have been successfully exported to the folder created in 
step 6.
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Export Alarms to XML File

Follow these pre-conversion steps to export alarms in your converted 
application to an xml format.

1. Navigate back to the open instance of the FactoryTalk View Studio 
software.

2. In the Application Explorer, right-click Alarm Setup and choose Import 
and Export.

3. Select Export alarm configuration from application and click Next.
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4. Accept the default file name Alarms and click Finish.

The alarms have been successfully exported to the alarms.xml file.

The default location for the alarm.xml file is:

C:\Documents and Settings\All Users\Documents\RSView 
Enterprise\ME\HMI Projects\Project_Name\Alarms.xml
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Run the Tag Converter Wizard

Now that you have completed the pre-conversion process, you are ready to run 
the tag converter wizard. The executable file is named TCW.exe.

During the conversion, most of the tags are converted to direct reference tags. 
You will have to manually set scale and offset values for tags after the 
conversion.

1. Double-click the TCW.exe utility.

2. Select the HMI Tag ->Direct Tag conversion type.

3. Click the ... button next to the Exported Tag Database field and load the 
exported tag database.

The file is located in the directory that is specified in step 6 on page 95.

4. Click the Add button next to Exported alarms/displays.

5. Load the exported alarms and display xml files.

The alarms file is located in the folder that is specified under step 4 on 
page 102.

TIP The original HMI tag database is not altered. 
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The xml display files are located in the folder that is specified in step 6 
on page 98.

Hold down the Shift key and select all displays to load all displays at 
once.

6. In the Destination Directory field, click the ... button to specify any 
location for the new xml display files.

The example that is shown may look different depending on the 
network protocol of your application.
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7. Click Next to continue the conversion.

The Report dialog box shows the number of tag and display 
substitutions made.

8. Click Finish.

A conversion log file, Conversion_Log.txt, is created and stored with the 
converted xml files.
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The conversion process is complete. The utility has successfully 
converted all HMI device tags to alias or direct reference tags in all 
displays.

In addition to the conversion log file, the tag converter wizard generates a tag 
cross-reference .csv file in the destination folder. This file cross-references HMI 
tags to alias and direct reference tags. 

When you open the .csv file in Excel, three columns show how the tags are 
linked.

Reimport the Display XML File

Now that you have converted all alarms and displays, you are ready to reimport 
the information into your application.

Follow these steps to reimport the xml display files to your application.

1. Navigate back to the open instance of the FactoryTalk View Studio 
software.

2. In the Application Explorer, right-click Displays and choose Import and 
Export.

HMI Tag Alias Tag Direct Reference Tag

Tag1 MotorSart1 N7:0

IMPORTANT Manually copy the BatchImport_Your_Project_Name.xml file to the 
location of the new displays that are created by the TCW utility. Select the 
xml file from this folder so all new displays are imported, not the original, 
unmodified displays.
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3. Select Import graphic information into displays and click Next.
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4. Select No to not back up the displays. 

You completed this action when you exported graphic displays to xml 
format on page 97.

5. Click Next.

6. Select Multiple displays batch import file and click Next.

7. Click the ... button.
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8. Select and open the BatchImport_Your_Project_Name.xml

9. Select Update existing objects on the display.

10. Click Finish.

11. Review the DisplaysImport.txt file for errors.

The new alias and direct reference tags have been successfully imported 
into the application.
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Reimport the Alarms XML File

Follow these steps to reimport the xml alarms file to your application.

1. Navigate back to the open instance of the FactoryTalk View Studio 
software.

2. In the Application Explorer, right-click Alarm Setup and choose Import 
and Export.

3. Select No to not back up the alarms. 

4. Click Next.

5. To select the Alarms.xml file from created by the TCW utility, click the 
... button.
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6. Click Finish.

The project has been successfully updated with the new alarms.

You can now retest your application for optimized performance.
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Advanced Object Editing

Introduction Editing techniques can save you time when using FactoryTalk® View Studio 
software. Use these techniques to reduce the migration effort when updating 
common properties between multiple graphic objects:

• Property panel
• Editing multiple objects
• Object explorer
• Tag substitution

Property Panel The property panel is a powerful editing tool that you can use to perform quick 
edits and tag assignments by simply clicking a graphic object. You can modify 
the property values of graphic objects, and assign tags and expressions to 
objects. Any edits that you make in the property panel are applied immediately.

Follow these steps to open the property panel.

1. With a graphic display open, choose View>Property Panel.

The property panel may not contain any information in it.  This status is 
the result of not selecting an object.
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2. Select a graphic object on the display.

This example shows a text object selected. The property panel shows all 
properties that you can edit for the selected object.

3. To view and edit the tag connection properties for the selected object, 
select the Connections tab.

This example shows the Value and Polarity connections for a numeric 
display object.

Edit Multiple Objects One of the most useful features of the property panel is that you can edit 
multiple graphic objects with common properties simultaneously, rather than 
editing each object, one by one.

Chapter 6, Review Unsupported Features, showed you how to create 
replacement multistate indicator, local message and numeric data display list 
objects in FactoryTalk View ME software. Creating this replacement graphic 
objects also required you to update properties to match the original 
PanelBuilder®32 objects. These properties included captions, foreground/
background colors, text size, number of states, and more. 
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Follow these steps to change a few properties for a group of ten multistate 
indicator objects.

1. Select a group of graphic objects you want to edit.

If your objects are not grouped, simply hold down the Ctrl key and click 
each object.

When a set of grouped objects are selected, the property panel shows 
only the grouped properties.
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2. Click the Include Grouped Objects button on the property panel.

You see all properties that can be edited for the objects in the group.

Clicking any property provides a popup, pull-down menu, or other 
editing method.

In the next step, you will change the ST_Caption from **** to State 0 
and the ST_BackColor to Green. These changes are then  applied to all 
selected objects for the state that is defined in the State property.

To change other states, simply change the State property to State1 and 
make the desired edits.

3. Click the ... button next to St_Caption.
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4. Type the new caption in the String Edit dialog box and click OK.

5. Click the ... button in the St_BackColor field. 

6. In the color palette that opens, click a new color.

The example shows the grouped objects before and after edits.

Depending on the object you are editing, the properties differ. Help text 
at the bottom identifies what the property does.

Object Explorer The object explorer provides a tree-list of all objects in the selected display. You 
can select and highlight objects in this list. 

Groups are listed as expandable items, with the + icon. To view the objects in a 
group, click the + icon or double-click the group name. The list expands to 
show the objects and groups within a group.

You can use the highlight settings to highlight specified objects on both the 
graphic display and object explorer. You can select objects by object type, by 
animation type, or by tag name.

For a display with many objects, object explorer provides an efficient way of 
locating and selecting graphic objects. If you want to edit specific objects, 
object explorer can highlight these objects for you. By using the property panel, 
you can do one the following:

• Perform multiple edits instantly

Before Edits After Edits

TIP You can apply this editing technique to cursor llst objects, depending on the 
number of objects. This action saves you time when updating your objects 
in FactoryTalk View ME software to match the original PanelBuilder32 
object.
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• Double-click the object in object explorer to open the properties dialog 
box and make edits to a single object

Follow these steps to open object explorer.

1. With a graphic display open, choose View>Object Explorer.

2. Expand or collapse groups of objects by clicking the Expand or Collapse 
buttons.

The objects that appear in the list differ for each display.

3. To search for objects, click the Settings button.

The Highlight Settings dialog box allows you to search for objects by 
Object Type, Animation Type, or Tag Name.

When selecting by tag name, the list shows all tags and expressions that 
are referenced by objects in the display, except tags with embedded 
variables.

4. Select Local Message Objects to search for all local message objects.
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5. Click OK to return to the object explorer.

6. Check the Highlighting on checkbox and click the Expand button.

The object explorer highlights all local message displays in red.

Local message objects on the display also appear red with a border.

If you have a display with a red background, the red highlights are not 
visible.
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When you select an object in the object explorer, the Highlight mode 
turns off. Simply, recheck the Highlight on box to turn the highlights 
back on.

7. To open the properties for the local message display, double-click an 
object in the object explorer.

8. Edit the properties and click OK.

Display Object
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If the property panel and object explorer are both open, click any object 
in object explorer. The property panel updates the display with the edit 
properties for the selected objects. You can make any updates from the 
property panel.
Rockwell Automation Publication 2711P-AP006E-EN-P - August 2022 121



Appendix A            
Substitute Tags You can use tag substitution to replace tag names or character strings in all 
selected graphic objects on a display. Character strings include tag 
placeholders, expressions, and parts of strings within expressions. When 
replacing tags, you can use an entire tag name, including folders, or you can 
replace a string of characters.

Tag substitution is useful when your graphic displays use a direct reference tag 
name or if an HMI Tag name is referenced throughout your application and 
must be updated.

Follow these steps to substitute a tag or character string.

1. Open the graphic display that you want to update.

2. To select all objects in the display, press Ctrl-A.

All objects on the display are highlighted. This example display is for 
illustration purposes only.

TIP You cannot use wildcard characters when searching for or replacing tag 
names.

TIP You must select all objects or the Tag Substitution dialog box  only shows 
tags of the selected objects. 
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3. Choose Edit>Tag Substitution.

In the Tag Substitution editor, you can search on an existing name or a 
part of a tag name.

4. Type mem in the Search for box.

5. Type tag in the Replace with box.

Uncheck the Confirm Replacement option, if you don’t want to confirm 
every replacement.

6. Click Replace.

The editor searches for each tag that contains the partial string mem and 
replaces the string with tag. You are prompted to confirm each 
replacement. 
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7. Click Replace All to confirm the replacement of all tags at once.

You are notified when the substitution is complete.

8. Click OK.

9. To verify that tags with the string mem were updated to tag, choose 
Edit>Tag Substitution.

You can use tag substitution on a display-by-display basis to verify that all tags 
or partial strings are updated correctly in the application.
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Migrating PanelView Standard Applications to PanelView Plus 7 Migration Guide

Additional Resources
These documents contain additional information concerning related products from Rockwell Automation.

You can view or download publications at rok.auto/literature.

Resource Description
Adapter Kit for PanelView 5500 and PanelView Plus 7 Performance Terminals 
Installation Instructions, publication VIEW-IN002

Provides information on how to install a PanelView Plus 7 terminal into an existing cutout 
from a PanelView Standard terminal.

Legacy PanelView Terminals to PanelView Plus 7 Terminals Catalog Number 
Conversions Migration Guide, publication 2711P-AP005

Provides information on how to convert legacy 2711 PanelView Standard terminals and 2711E 
PanelView Enhanced terminals to the new generation terminals: PanelView Plus 7 Standard 
terminals and PanelView Plus 7 Performance terminals.

PanelView Plus 7 Performance Terminals User Manual, publication 2711P-
UM008

Provides information on how to install, operate, configure, and troubleshoot PanelView Plus 
7 performance terminals.

PanelView Plus 7 Standard Terminals User Manual, publication 2711P-UM007 Provides information on how to install, operate, configure, and troubleshoot PanelView Plus 
7 standard terminals.

Visualization Solutions Selection Guide,
publication VIEW-SG001 Provides an overview of visualization products, including PanelView Plus 7 terminals.

FactoryTalk View Studio online help Provides information and procedures on how to create FactoryTalk View Machine Edition 
applications and supported features.

Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1 Provides general guidelines on how to install a Rockwell Automation industrial system.
Product Certifications website, rok.auto/certifications Provides declarations of conformity, certificates, and other certification details.

https://www.rockwellautomation.com/en-us/support/documentation/product-certifications.html
https://rok.auto/literature
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/view-in002_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/ap/2711p-ap005_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2711p-um008_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2711p-um008_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2711p-um007_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/sg/view-sg001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1770-in041_-en-p.pdf


Publication 2711P-AP006E-EN-P - August 2022
2711P-AP006D-EN-P - March 2021 Copyright © 2022 Rockwell Automation, Inc. All rights reserved. Printed in the U.S.A.

Allen-Bradley, AutoMax, ControlLogix, DH+, Encompass, expanding human possibility, FactoryTalk, Logix5000, PanelBuilder, PanelView, PLC-5, Rockwell Automation, RSLinx, RSView, and SLC are 
trademarks of Rockwell Automation, Inc.
EtherNet/IP is a trademark of ODVA, Inc.
Trademarks not belonging to Rockwell Automation are property of their respective companies.

Rockwell Otomasyon Ticaret A.Ş. Kar Plaza İş Merkezi E Blok Kat:6 34752, İçerenköy, İstanbul, Tel: +90 (216) 5698400 EEE Yönetmeliğine Uygundur

Rockwell Automation Support
Use these resources to access support information.

Documentation Feedback
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our 
content, complete the form at rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)

Rockwell Automation maintains current product environmental compliance information on its website at rok.auto/pec.

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification updates. rok.auto/support
Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport
Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature
Product Compatibility and Download Center 
(PCDC)

Download firmware, associated files (such as AOP, EDS, and DTM), and access product 
release notes. rok.auto/pcdc

At the end of life, this equipment should be collected separately from any unsorted municipal waste.

https://rok.auto/support
https://rok.auto/knowledgebase
https://rok.auto/phonesupport
https://rok.auto/literature
https://rok.auto/pcdc
http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf
https://rok.auto/docfeedback
https://rok.auto/pec
https://www.instagram.com/rokautomation/
https://www.linkedin.com/company/rockwell-automation
https://twitter.com/ROKAutomation
https://www.facebook.com/ROKAutomation/
https://www.rockwellautomation.com/
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